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The Natural Heritage & Endangered Species Program's goal is the protection of

the state's native biological diversity through a comprehensive program ofbiological

inventory and scientific research, species and habitat management and restoration,

environmental impact review, and conservation planning. The Program is funded

largely by the Commonwealth's General Fund as well as by voluntary contributions

to theNH&ES Fund on Massachusetts' income tax forms and by the Inland Fish&
Game Fund. The Program also is an active participant in the evaluation and selection

of lands purchased by the Division ofFisheries & Wildlife.

"With support from

Executive Office of

Environmental Affairs

Commonwealth of Massachusetts

This project was supported by bond funds made available by the Executive Office

ofEnvironmental Affairs. Bond funds supporting the Massachusetts Aerial Photo

Survey of Potential Vernal Pools also supported a series of seven vernal pool

workshops for educators held throughout the Commonwealth in the spring of200 1

.

The Massachusetts Aerial Photo Survey ofPotential Vernal Pools has been funded

as a component of the Natural Heritage Program's BioMap Project, a statewide

effort to identify and map areas of critical conservation concern. BioMap will

result in an important tool for prioritizing open space protection, acquisition and

community preservation planning, as well be valuable to state and federal

environmental agencies, local conservation commissions, planning boards and land

trusts.

Copies of this publication are available through the Massachusetts Division of

Fisheries & Wildlife's Natural Heritage & Endangered Species Program, Route

135, Westborough, MA 01581, (508) 792-7270 ext. 200.



SWassachuseZts

Aerial Photo Survey of

Potential Vernal Pools

Spring 2001

Matthew R. Burne
Vernal Pool Ecologist

Natural Heritage &. Endangered Species Program

Massachusetts Division of Fisheries <Sl Wildlife

Route 135, Westborough, MA 01581



^\ckno vJlebftmen ts

Thanks are due to the following people for their help in the realization ofthis major

undertaking. This survey has been an underlying goal ofthe Natural Heritage

Program's vernal pool work for nearly 7 years, and the project's conception and

ultimate execution has been aided by many people along the way.

Special thanks to Henry Woolsey and Patricia Huckery, Dr. Elizabeth Colburn,

Scott Jackson, Leo Kenney, Jim MacDougall, Dr. Steven Meyer, Heidi Roddis,

Janice Stone, and Dr. Bryan Windmiller

Thanks also to:

Kyla Bennett, Collette Blais, Jack Buckley, ArthurBurgeron, Alan and Janet Burne,

Matthew Cloutier, Charles Costello, Lisa Dennehy, Robert Durand, Andy Finton,

Suzanne Fowle, Aleda Freeman, Dr. Thomas French, David Gabriel, Chris

Gaughan, Robert Golledge, David Goodwin, Shirley Griffin, Ed.D, Melissa Griffiths,

Michael Harney, Christian Jacqz, Dr. David King, Alicia LeFort, Wayne

MacCallum, Stafford Madison, Amy Maher, Sharon McGregor, Mike McHugh,

Dr. Scott Melvin, Joan Milam, Peter Mirik, Stephanie Neid, Jessica Patalano,

Jane Pierce, Jessica Schedlbauer, Tim Simmons, David Szczebak, Richard

Tomczyk, Christine Vaccaro, Alison Whitlock, and Sally Zielinski.

tl



'Preface

The Massachusetts Executive Office ofEnvironmental Affairs seeks

to engage citizens of the Commonwealth in the study, appreciation, and

protection ofvernal pool habitat. The Natural Heritage & Endangered Species

Program oftheMA Division ofFisheries & Wildlife is the state agency entrusted

with the responsibility to oversee the official vernal pool certification program

and to pursue research, education and outreach efforts that will enhance

appreciation and protection for vernal pools in the state. This publication

presents the first comprehensive aerial photo survey ofpotential vernal pools

in Massachusetts. It is a statewide inventory of potential vernal pools that

have been identified from aerial photographs. This survey represents a

tremendous leap forward in the protection of this resource by providing, at a

glance, the most complete picture available to date of the number and

distribution ofvernal pools across the Commonwealth.

Rather than on printed maps, the locations ofphoto-identified vernal

pools are presented on a compact disc, developed by MassGIS, which is

found at the back of this booklet. The compact disc contains a simplified

version of the MassGIS Runtime Data Viewer with statewide USGS
topographic maps and all ofthe potential vernal pools identified during this

project. While the potential vernal pool data does not identify all vernal pool

habitats in the state (many are not visible on aerial photographs), this will,

nonetheless, provide a great tool for the conservation ofmany vernal pools.

The Massachusetts Aerial Photo Survey ofPotential Vernal Pools does

not replace the role ofofficial state certification ofvernal pools in the protection

ofthese habitats. However, it does provide interested parties with valuable

information on the occurrence ofpotential vernal pools that can then be verified

in the field. School groups, land trusts and non-governmental organizations,

local boards and commissions, landowners and environmental consultants

should find the information presented useful in many ways.
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'Trespass

The Executive Office of Environmental Affairs (EOEA) urges

Massachusetts' citizens to take interest in vernal pool study, appreciation, and

protection. However, EOEA strongly recommends that anyone interested in

field verification ofpotential vernal pools or vernal pool certification obtain

landowner permission prior to conducting any data gathering. No one pursuing

official vernal pool certification should trespass on legally posted property

under any circumstances. Please refer to the model letter for landowner

permission (Appendix A) for help in drafting a letter seeking permission.

The Natural Heritage & Endangered Species Program of the

Massachusetts Division ofFisheries & Wildlife maintains a file for every vernal

pool that is certified. All information contained in these files, including the

official field observation form and it's contents, are a part ofthe public record

and may be requested through an official documents request.

iV
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ARGEOPAULCELLUCCI
GOVERNOR

JANE SWIFT
LIEUTENANT GOVERNOR

BOB DURAND
SECRETARY

Dear Concerned Citizen,

Spring, 2001
Tel. (617) 727-9800

Fax (617) 727-2754

http://www.magnet.state.ma.us/envir

Dear Concerned Citizens,

As Massachusetts' Secretary of Environmental Affairs, one of my top priorities is to help

citizens reconnect to the natural world. A principal component of this goal is to create opportuni-

ties for children and adults to physically explore their environment. The Massachusetts Aerial

Photo Survey of Potential Vernal Pools provides an important tool that will help the citizens of

Massachusetts connect with these wonderful habitats that are found across our landscape.

Vernal pools are unique wetlands that support diverse and valuable wildlife communities,

including many state-listed rare species, such as species of mole salamanders and the graceful,

intricate fairy shrimp. Vernal pools come in a diversity of forms, but all are characterized by

springtime ponding, a lack ofreproducing fish populations, and the wildlife communities that are

adapted to these conditions. Despite their variety in size and physical characteristics, they are all

very important to the long-term preservation of biodiversity in our communities.

The Executive Office of Environmental Affairs (EOEA's) Vernal Pool Initiative seeks to

engage citizens of the Commonwealth in the appreciation, study and protection of vernal pool

habitat. This statewide inventory of potential vernal pools, through educational outreach and

publications, will foster both interests in and understanding of vernal pool habitat.

Using a series of aerial photographs indicating potential vernal pools across the state as a

guideline, citizens will join experts in the field to identify and certify vernal pool habitats. State

laws protecting vernal pools from intrusive actions require physical assessment of the site for

certification. Thus, field verification of potential vernal pools is essential to their protection.

I encourage school groups, children and parents, land trusts and non-governmental

organizations, local boards and commissions, landowners and environmental consultants to join

EOEA in this important initiative. If you choose to participate, please be certain to obtain permis-

sion to access any private or public property before searching for vernal pools.

I hope you take advantage of this opportunity and I look forward to your participation.

truly yours,

urand

© Printed on Recycled Stock 20% Post Consumer Waste



Digitized by the Internet Archive

in 2013 with funding from

Boston Library Consortium Member Libraries

http://archive.org/details/massachusettsaerOOburn



Aerial Photo Survey of Potential Vernal Pools

Contents

^Aerial 'Photographic Interpretation of "Vernal 'Pools

Introduction 3

Defining vernal pool habitat 5

Aerial photography primer 6

Interpretation ofpotential vernal pools 8

The Massachusetts Aerial Photo Survey ofPotential Vernal Pools 10

PVP versus CVP 13

Vernal pool protection in Massachusetts 14

"Using the MassQld "Data "VieWer anb "Potential "Vernal 'Pool "Vata

NHESP Potential Vernal Pool Metadata: Synopsis ofthe

PVPdatalayer 21

Installing the MassGIS Runtime Data Viewer 22

Starting the Data Viewer 24

Getting started 26

Introduction to ArcView and the MassGIS Data Viewer 28

Resources

Official Guidelines for the Certification ofVernal Pool Habitat

Vernal Pool Fact Sheet 49

Certification Criteria 53

Vernal Pool Field Observation Form (perforated) 57

Rare Animal Observation Form (perforated) 61

Suggested Reading 63

References 64

^AppenbCces

A. Model Letter for Landowner Permission 67

B. Vernal Pool Protection - the Local Bylaw 71

yJii Massachusetts "Vernal "Pool Surrey





^\eriai *Vhoto$raphCc

Interpretation of Vernal "Tools

Introduction

Defining vernal pool habitat

Aerial photography primer

Interpretation of potential vernal pools

The Massachusetts Aerial Photo Survey of Potential

Vernal Pools

PVP versus CVP

Vernal pool protection in Massachusetts





Aerial Photo Survey of Potential Vernal Pools

^Aerial 'Photographic Interpretation of 'Vernal 'Fools

Introduction

Interest in vernal pool ecology and the biology of the plants and

vertebrate and invertebrate animals that rely on vernal pools has been growing

tremendously in Massachusetts, aroundNew England, and beyond. The value

ofvernal pool habitat as a living classroom, for its diversity of wildlife and

ecological processes, has resulted in the inclusion ofvernal pool study at many

grade levels in school systems throughout the Commonwealth. The importance

ofvernal pools to the conservation ofamphibian and invertebrate wildlife, as

well as biodiversity more generally, across the state has also been recognized

in recent years. Vernal pools that have been officially "certified" by the

Massachusetts Division ofFisheries and Wildlife (DFW) receive important

protection under several state wetland protection regulations. Since the

certification program relies on the public to collect documentation, it has led

to a considerable increase in public awareness and participation in the

protection of these important wildlife habitats, as well as the state's other

wetland resources, by individuals, community groups, non-government

organizations, and local and state government agencies.

Prior to this aerial survey, no comprehensive vernal pool inventory

had ever been attempted in Massachusetts. However, the DFW's Natural

Heritage & Endangered Species Program (NHESP) maintains a database of

all certified vernal pools, the only statewide database concerning these habitats.

This database has grown slowly since it was established in 1988. Data

generated by voluntary efforts to identify and document vernal pools constitutes

the vast majority ofthe information it contains. This has resulted in a patchy

distribution of certified vernal pools, focused in areas that have had active

individuals and groups working to identify them, rather than reflecting the true

distribution ofvernal pool habitat throughout the state (Figure 1 ). Reliance on

this source of information results in no clear picture of the abundance,

distribution or conservation status ofvernal pool habitat across Massachusetts.

Protection ofvernal pools is therefore also inconsistent across the state and
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focused in those areas that have

undergone extensive, localized

inventories. It is difficult to perform

effective or pro-active conservation

planning or management for the

protection ofvernal pool habitats and

the biodiversity that they support

without first knowing their distribution

and the degree to which they are

protected.

Aerial photographic

interpretation (photogrammetry)

enables rapid and large-scale
Figure 1: Distribution of Certified Vernal Pools in MA

inventories ofnatural communities and landscape features. Vernal pools are generally

visible on certain types of aerial photographs, permitting their inventory by

photogrammetry. However, in Massachusetts, vernal pools are defined by the wildlife

that use them rather than by the physical characteristics that make them visible on

aerial photographs. Since wildlife can not actually be seen on aerial photographs,

vernal pools identified on aerial photographs are known as "potential vernal pools"

(PVPs) due to the possibility that they do not support vernal pool indicator wildlife.

Several scientific studies in Massachusetts have proven that aerial photographic

interpretation is highly effective for the identification ofpotential vernal pools which

likely support populations ofindicator wildlife (discussed below in Interpretation of

Potential Vernal Pools). Aerial photo interpretation represents the best presently

available tool for conducting a statewide inventory ofpotential vernal pool habitat.

The NHESP has conducted this survey by interpreting potential vernal pools from

1 : 12,000 scale color infra-red aerial photographs. The potential vernal pools identified

during this survey have been digitized in the Massachusetts Geographic Information

System (MassGIS), and will be included in the MassGIS library of data. A compact

disc has been developed and is included as a part ofthis publication which contains a

stand-alone Runtime Data Viewer software package, selected MassGIS data layers,

and the USGS topographic maps of the state. The data viewer allows anyone with

an IBM-compatible computer (running Windows 95, 98, 00 orNT with a minimum of

32MB RAM) or Macintosh capable ofrunning emulation software to view a map of

the state with the USGS topographic maps, some data including town boundaries and

major hydrological features, and the points representing all of the potential vernal

pools. Zooming into a particular area of interest will allow individuals to print detailed

maps ofpotential vernal pools for use in the field. The potential vernal pool data set

»v»
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is also available on the MassGIS website (www.ma.state.us/mgis) which

allows anyone with internet access to create maps and print them out from a

standard internet browser.

Defining vernal pool habitat

Obligate species
Mole salamanders

Spotted
Blue-spotted

Jefferson

Marbled

Wood frog

Fairy shrimp

Facultative species
Spring peeper
American toad

Green frog

Pickerel frog

Gray treefrog

Four-toed salamander
Spotted turtle

Caddisfly larvae

Dragonfly larvae

Fingernail clams
Amphibious snails

Table 1: Some vernal pool

indicator species

In Massachusetts, vernal pools are defined rather broadly. They are

distinguished primarily by indicator wildlife species and the absence offish,

rather than by physical characteristics such as hydroperiod, landscape position

or vegetative community. Vernal pools are generally defined as basin

depressions where water is confined and persists for at least 2 months during

the spring and early summer ofmost years, and where reproducing populations

of fish do not survive. Specifics regarding hydroperiod, vegetative

characteristics, connections to other wetlands and waterbodies and other

physical characteristics are the stuff of great debate. What is relied upon

above all else is the documented presence of obligate or facultative indicator

wildlife.

Vernal pool indicator species (Table 1) are generally able to use wetlands

oftremendously varied physiographic conditions ifthe breeding habitat remains

flooded for at least 2 months and is free of established,

reproducing fish populations. Defining vernal pool habitat

by indicator species rather than specific physical

characteristics means that there is a wide diversity ofhabitat

characteristics found in vernal pools. Blue-spotted

salamanders (Ambystoma laterale) are as likely to be found

breeding in a dense, shrub-dominated wetland as they are a

classic kettlehole depression. Hydroperiods, landscape

position and vegetation characteristics, among other physical

characteristics, run the gamut. Vernal pool habitat therefore

occurs in deep kettlehole depressions, among the small

pockets of standing water in wooded swamps with pit and

mound topography, in open marshes, shrub swamps, fens,

interdunal swales, and other wetlands that are free of

established, reproducing fish populations, and that contain

standing water for at least 2 months in the spring and summer

ofmost years. Vernal pools may be very shallow, holding

only 5 or 6 inches ofwater at their maximum depths, or they

may be quite deep. On average though, pools tend to hold

CWasscichusetts 'Vernal 'Fool 3urVey



2-3 feet ofwater during the spring time maximum flooding. They may be

extremely small, fewer than 100 square feet in some cases, or reach several

acres in size.

Among the debates over characteristics of the wetlands that may be

called vernal pools, the very term is often argued. "Vernal pool" is an apt

name for the spring-time pools ofCalifornia where the term was coined. There,

temporary pools are filled with annual spring (vernal) rains and reliably dry by

early summer. Vernal pools in Massachusetts tend to begin filling in the fall,

and among those that dry every year, many hold water well into the summer or

even early fall. In Massachusetts the term is technically a misnomer, but has

become inextricably linked to these seasonally-flooded wildlife habitats. Terms

such as autumnal pools, seasonal forest ponds, and seasonally flooded

depressions may describe these habitats more accurately, but have not begun

to replace the widely-used "vernal pool."

Aerial photography primer

Aerial photo interpretation is used extensively for the inventory and

mapping oflandscape features, both natural and man-made. Photo interpreters

can use tools such as a mirror stereoscope (Figure 2) to view the landscape in

an effort to identify features of interest for a particular project. Photographs

of the landscape can be taken with satellites

from space or with cameras from airplanes

resulting in a view looking straight down at the

earth's surface. When photographs are taken

from directly overhead, a unique perspective is

gained that allows the photo interpreter to see

landscape features that might be difficult or

impossible to distinguish from other vantages.

Aerial photographs can be taken such that two

sequential photographs viewed under a mirror

stereoscope produce a 3-dimensional view of

the earth's surface. This phenomenon allows

photo interpreters to read topographic features ofthe ground such as hills and

depressions, and even allows the measurement ofan object's height. Different

landscape features can be emphasized in aerial photographs by selecting from

a wide array ofpossible scales, emulsions (e.g. black and white versus color),

and time ofyear that the images are taken, all ofwhich are discussed below.

Figure 2: Mirror stereoscope

,l»Vt
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Figure 3: Map scale comparison

The scale ofa photograph refers to the number

of units (e.g. inches) on the ground surface that the

same unit on the photograph represents. For instance,

the photographs used to create this survey are at a

scale of 1:12,000. On these photos, one inch

represents 12,000 inches (or 1000 feet) on the

ground. Smaller scale photography (e.g. 1 :25,000)

provides a view ofmuch more of the earth's surface,

while larger scale photography, such as 1:12,000,

shows considerably more detail (Figure 3). However,

covering large areas with larger scale photography

requires many more individual pictures and much more

time to interpret. In selecting the appropriate

photographic scale for a particular project, photo

interpreters balance the benefit ofgreater detail with

the costs of increased effort associated both with

obtaining and interpreting greater numbers of

photographs. 1 : 1 2,000 scale photographs allow for

fairly small vernal pools (<100' diameter) to be

identified, yet cover the state with a reasonable

number ofindividual images (approximately 10,000).

Aerial photographs are available in different film emulsions such as

black and white, true color and color infra-red (CIR). Color infra-red film is

very commonly-used in wetland and vegetation mapping. It is sensitive to

wavelengths oflight from the infra-red portion ofthe light spectrum. Different

types ofvegetation reflect various amounts ofinfra-red light and create unique

"signatures" that allow photo interpreters to distinguish different vegetation

types (conifer versus deciduous trees), associations, and even individual

species. This type offilm is also very useful to wetland mapping efforts since

standing water appears dark blue to black and is quite distinctive.

The time ofyear at which photographs are taken is also an important

tool in highlighting various features ofthe landscape that might be of interest.

In areas ofdeciduous trees, prior to "leaf-out" in the spring, the ground surface

can be clearly seen. Leaf-offphotography is very useful in distinguishing the

edges ofwater bodies that are obscured as leaves come out on canopy trees,

and is critical to detecting small features on the landscape that can be completely

obscured when the tree canopy is fully leafed-out. As the spring progresses,

a period ofearly leafemergence, called "first blush," can be photographed to

Massachusetts 'Venial 'Fool SunJey



help distinguish between different hardwood tree species. Full leaf-out

photographs are useful in identifying major vegetation associations, but are

nearly useless for identifying small features underneath the tree canopy.

Interpretation of potential vernal pools

Use of color infra-red (CIR) leaf-off aerial photography for

interpretation ofwetlands is particularly effective. Open water bodies appear

as black features and different vegetation types have distinctive signatures

that allow skilled interpreters to distinguish between various plant species and

communities. "Classic" vernal pools, isolated basin depressions with little or

no vegetation, are readily interpreted from this type ofphotography. Without

leaves obscuring the forest floor, the standing water ofspringtime vernal pools

stands out within topographic depressions. For the classic pool, size becomes

a primary consideration. Very small pools at the lower limit ofresolution (<

60' diameter) are unreliably interpreted at the scale of 1 : 12,000. Surrounding

forest cover also becomes important as size decreases. Coniferous forest

cover obscures all but the pools that are large enough to create a gap in the

canopy. Pools that have well-developed shrub or emergent vegetation are

often easily identified by the standing water and vegetation "signatures" on

spring-time CIR photography.

Several studies conducted in Massachusetts have demonstrated the

effectiveness of aerial photo interpretation ofvernal pool habitat. The first

study to specifically address this tool for use in vernal pool identification was

a Master's thesis by Janice Stone (1992) at the University OfMassachusetts

Amherst. She showed that 1 :4800 scale black and white aerial photographs

could be used effectively to identify vernal pools that were providing habitat

to obligate vernal pool-breeding species (mole salamanders, wood frogs and

fairy shrimp). While this proved that aerial photography could be used for

identifying vernal pools, the scale ofphotography was not useful for large

areas, such as a statewide inventory. The NHESP performed a small-scale

test of the effectiveness of 1 : 12,000 scale color infra-red aerial photographs

in 1996. The use of this scale and emulsion proved highly effective, with

greater than 90% of the interpreted "potential vernal pools" verified in the

field as providing habitat to vernal pool obligate species (unpubl. data, NHESP).

Brooks, Stone and Lyons (1998) reported that interpretation of 1:12,000

scale CIR photography for seasonal forest ponds, wetlands that typically

function as vernal pool habitat, was very effective in the large Quabbin Reservoir

%



watershed. They reported that the quality of photography and experience of

the interpreter resulted in very limited errors of commission (identifying

something, such as a tree shadow, as a seasonal forest pond that was not

actually a waterbody), less than 5%. Furthermore, among a sample of

interpreted seasonal forest ponds, greater than 85% that were field verified

during the spring amphibian breeding season were found to function as vernal

pool habitat. In 1 999 the NHESP conducted its second trial using 1 : 1 2,000

scale CIR photographs across a randomly selected sample ofaerial photographs

in Barnstable, Plymouth, Essex, Middlesex and Worcester Counties. Errors

ofcommission were extremely low (<3%), and greater than 80% ofthe potential

vernal pools that were field-verified were providing breeding habitat to vernal

pool indicator species (unpubl. data, NHESP). The year in which this second

test was conducted experienced an extremely dry spring where many vernal

pools dried up completely as early as the end of April. This affected the

number ofpools that could be confirmed to provide vernal pool habitat. It is

expected that, in a more typical year, even better results would have been

achieved.

While aerial photo interpretation is very effective in the identification

ofpotential vernal pools, it is not a fool-proofmethod ofinventorying all vernal

pool habitats that exist in the survey area. Two types of error occur in any

resource mapping using aerial photographs: errors ofcommission and errors

ofomission. When interpreting vernal pool habitat, errors ofcommission are

those in which a feature on the photograph is identified as a vernal pool when,

in fact, it is not. Shadows of large trees can be mistaken for a small ponded

water body, for example. The quality of 1 : 12,000 scale CIR photography is

excellent. However, as interpreters attempt to identify pools that are extremely

small, the reliability ofthe interpretation becomes compromised (Brooks et al,

1998). Errors ofcommission also occur when a water body is identified as a

vernal pool when it does not, in fact, meet the required physical or biological

characteristics required to classify it as a vernal pool. For instance, a ponded

waterbody might dry extremely quickly after a significant rain storm filled it.

Photo interpreters will often be unable to distinguish these very ephemeral

waterbodies from more permanent ones that will function as vernal pools.

These types of errors occur infrequently, but must be acknowledged in any

survey produced by aerial photo interpretation. Errors of omission are the

other common error in aerial photo interpretation. These occurwhen an existing

feature, such as a vernal pool, is overlooked. As discussed above, very small

vernal pools can not be identified with great reliability in all circumstances.

Massachusetts ^Vernal 'Vool $ur\7ey



This is particularly true in areas where tree shadows may obscure the forest

floor and where topographic relief is slight and gives no additional clues to the

interpreter. In areas with a lot ofevergreen vegetation, it is difficult or impossible

to see the forest floor. Photo interpretation of vernal pool habitat, or other

features on the ground, is typically very difficult and particularly subject to

errors of omission and commission in these areas. Furthermore, as leaf-out

progresses through the spring, the forest floor is increasingly obscured in areas

of deciduous tree cover when photography is taken later in the year (after

early to mid May in Massachusetts), and interpretation can be compromised.

The Massachusetts Aerial Photo Survey of

Potential Vernal Pools

The compact disc enclosed in this publication presents the loci of

potential vernal pools in Massachusetts that were identified from 1 : 12,000

scale color infra-red aerial photographs. This statewide coverage includes

the survey ofPlymouth and Bristol Counties published in the spring of2000.

The Massachusetts Potential Vernal Pool Survey has been produced for several

reasons. It provides an overview of the number and spatial distribution of

vernal pool habitats in the state. This provides an important tool for

conservation planning with respect to vernal pool habitat. By having an estimate

ofthe number ofvernal pools in the region, and a picture oftheir distribution,

it will be possible to better direct acquisition and regulatory protection efforts

for vernal pools. Vernal pool education and certification initiatives should also

greatly benefit from the production ofthis survey. It will provide the loci ofa

tremendous number ofpotential vernal pools in the state to landowners, school

and community groups, non-government organizations and non-profit

organizations, as well as local, state and federal government agencies.

Aerial photos used in the Massachusetts Potential Vernal Pool Survey

include images acquired in 1 993, 1 999, and 2000 (Figure 4). While generally

of exceptional quality, the Massachusetts Aerial Photo Survey of Potential

Vernal Pools contains a few problem areas resulting from photo quality or

other related causes. Stereo pairs were not available for the outer arm of

Cape Cod (from the eastern halfofBrewster/Harwich north to Provincetown)

and for all ofNantucket. Photo interpretation therefore was done without the

aid oftopographic reliefor the magnification of a stereoscope. It is expected

that more errors ofomission and commission will be found in these areas of

the state. The coastal dune systems from Barnstable to the outer tip of

10



A - Spring 2000

B - Spring 1999

C - Spring 1993

Provincetown contain

tremendous numbers of

interdunal swales. These quite

often provide breeding habitat

for Fowler's and spadefoot

toads, facultative invertebrates,

and other vernal pool indicator

species. Accurate

interpretation of vernal pools

among these interdunal swales

is difficult however, and it is

expected that errors are more

common among the potential

vernal pools interpreted from

Figure 4: Aerial photo project areas and dates of

photography

the dune systems ofCape Cod, the Islands, and the north shore. Initial surveys

ofsome potential vernal pools in Bristol County indicate that there may be

more errors ofcommission than in other parts ofthe state. This may be due in

part to comparative wetness ofthe photos used for interpretation in that county.

It is expected that fewer than 80-85% ofpotential vernal pools in Plymouth

and Bristol Counties will likely support breeding populations ofvernal pool

indicator wildlife. 1 999 photos used for Plymouth County were flown very

late in the spring (mid to late May), and suffered from early leafout conditions

which increases the probability of errors ofomission. Over the western half

ofthe county, much of the forest floor was obscured by tree canopy leaves,

affecting the interpretation of smaller pools that do not have an open tree

canopy. The floodplains ofthe Connecticut River and some of its tributaries

were extremely wet in the photography used. This results in a probable under-

accounting of the myriad potential vernal pools found among the sloughs,

backwaters, and oxbows of large river floodplain systems. The spring 2000

photos for Berkshire County had some areas of snow which obscure all

features. As a result, approximately 1 6,000 acres in southern Berkshire County

(Figure 5) were not interpreted for potential vernal pools. Spring 2000 photos

ofcentral Worcester county west ofBarre, through Petersham, were extremely

dark and therefore lacked sufficient detail for high confidence in the

interpretation ofpotential vernal pools in that portion ofthe state.

Photo interpretation itselfhas limitations and sources oferror. Very

small vernal pools are difficult to identify even with the highest quality

photography. Pools as small as ~42' diameter (0.0042" on the photograph)
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were occasionally identified.

However, pools smaller than about

50-60' in diameter could not reliably

be identified. Pools between 60' and

125' diameter were easily confused

with tree shadow and some types of

man-made features. Pools of 125'

diameter (1/8" on the photographs)

and larger could be reliably identified

when photos were of fair to excellent

quality, and where evergreen trees

were not dominant. The upper size

limit ofpotential vernal pools is quite

difficult to establish, and is generally Figure 5: Area affected by snow in So. Berkshire Co.

a subjective call. Some very large

features were pulled out as potential vernal pools when connections to other

water bodies did not appear to exist, and where vegetation signatures suggested

that the hydroperiod was not permanent. Farm ponds and other obviously

man-made waterbodies were generally avoided where it was possible to do

so. Furthermore, any potential vernal pool with more than 50% ofthe shore

line in managed vegetation (lawns, crops, etc.) was not included as a rule.

It is important to understand that this potential vernal pool survey does

not include all vernal pools in the state. Omission due to unfavorable conditions

in the landscape topography, pool physiography and/or photograph quality

(i.e. errors ofomission, discussed above) result in vernal pools that are missed

by photo interpretation. Furthermore, vernal pool habitat occurs in a wide

variety of landscape settings, including within forested swamps, bogs, and

other wetlands; within these settings vernal pools will typically not be photo

interpreted, but nonetheless provide legitimate and valuable vernal pool habitat.

MassGIS has produced a special compact disc with the Potential Vernal

Pool datalayer, select MassGIS data for the state of Massachusetts, and a

stand-alone Runtime Data Viewer application. Instructions for installing the

data viewer begin on page 22. The potential vernal pool data may be viewed

over USGS topographic maps and select MassGIS data to help identify the

exact loci of pools. Additional datalayers can be downloaded from the

MassGIS website (www.state.ma.us/mgis), including black and white aerial

photographs and boundaries of conservation and open space lands, for

example, to create customized maps with the runtime data viewer.
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PVP versus CVP

Potential vernal pools (PVP) identified in this survey are not to be

confused with certified vernal pools (CVP). Evidence of amphibians or

invertebrates using a vernal pool, in addition to proof that the pool does not

support an established, reproducing fish population must be presented to the

Natural Heritage & Endangered Species Program for certification to obtain

official standing as a certified vernal pool under state wetlands protection laws.

Potential vernal pools identified in this survey do not automatically receive

protection under the Massachusetts Wetlands Protection Act Regulations (3 1

CMR 10.00), nor under any other state or federal wetlands protection laws

that have specific language protecting certified vernal pools. However, the

Wetlands Protection Act regulations allow the local conservation commission

to protect the wildlife habitat value ofany resource area when it is demonstrated

to be important to wildlife. This demonstration can be through the presentation

of clear scientific evidence (such as that required for official certification) at

any time during the public hearing process.

It is important to note that there are considerable differences in the

precision with which the locations of vernal pools are mapped in both the

potential vernal pool and certified vernal pools data layers. The potential

vernal pools identified by aerial photo interpretation are actually located with

much greater precision than the points representing certified vernal pools in

the MassGIS. Potential vernal pools are digitized at a scale ofapproximately

1 : 12,000 on rectified orthophotographs. At that scale, points representing

potential vernal pools have a precision equal to less than +/- 1 5 feet or so

from the center of an interpreted pool. Note that as the view of a map in the

data viewer is zoomed in to larger and larger scales, the point representing a

potential vernal pool will migrate away from the true center ofthe pool because

the point was drawn at 1 : 12,000 scale. Certified vernal pools are currently

digitized by generating a latitude and longitude number measured on a paper

1 :25,000 scale USGS topographic map. Measurements made on these maps

have a precision of approximately +/- 50 feet in any direction. Therefore,

when comparing the PVP layer to the CVP layer there may well be some

disagreement between the two points representing the same vernal pool. It

may appear that the two layers do not match up when looking at points

representing the same pool. The local conservation commission is sent copies

ofthe maps that are submitted to the NHESP for certification. To be certain
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about the location of a certified vernal pool relative to potential vernal pools

that you might be working with, visit the conservation commission office and

ask to view the file they received from the NHESP when the pool was certified.

In addition, the layers are not exactly the same; some certified vernal pools

can not be seen on the aerial photographs (for various reasons) and are

therefore not included in the PVP data, and the vast majority of potential

vernal pools have not been certified.

So please take care in interpreting the differences in the PVP and

CVP datalayers, understanding that there will be inconsistencies between the

two, both real and perceived.

Vernal pool protection in Massachusetts

Massachusetts has long been one ofthe most progressive states in the

nation in protecting wetlands. It has been a leader in the protection ofvernal

pools through implementation ofregulations and programs that have resulted

in the identification and regulation ofmore than 2000 ofthese important wildlife

habitats. Vernal pools are protected under the Massachusetts Wetlands

Protection Act regulations (310 CMR 10.00), Surface Water Quality Standards

(314 CMR 4.00), subsurface sewage disposal regulations (Title 5:310 CMR
1 5.000) and the Forest Cutting Practices Act regulations (304 CMR 1 1 .00).

Many communities across the Commonwealth have also enacted additional

protection through local bylaws (see Appendix A) that can significantly increase

the protection of vernal pools beyond that which state regulations provide.

Wetlands Protection Act. Prior to 1986, the wildlife habitat

function of wetlands was not protected by the Massachusetts Wetlands

Protection Act (WPA, M.G.L. c.131 §40). Revisions to the Act in 1986

added wildlife habitat as a protected "statutory interest" to be considered

when permitting work in and around wetlands. Vernal pools were recognized

as important but often overlooked wildlife habitats. However, their protection

was not made automatic because "it would be unfair to applicants to require

them to conduct difficult, timely, expensive, and often inconclusive searches

for possible vernal pools" (Wetlands Protection Act Regulations Preface,

1 987). Thus, the vernal pool certification program was developed for use

with the Wetlands Protection Act regulations to identify and map vernal pools

that meet established physical and biological criteria. The program is

administered by the Natural Heritage & Endangered Species Program

(NHESP) of the Massachusetts Division of Fisheries and Wildlife. The
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certification program was developed to inform applicants, conservation commissions and

regulators of the occurrence of vernal pool habitat in advance of project proposals.

Through the Massachusetts Wetlands Protection Act regulations, local conservation

commissions regulate building and development that is proposed within and adjacent to wetlands

across the state. The Act protects wetland functions, referred to as the "interests ofthe Act."

Its regulations (3 1 CMR 1 0.00) define wetland resource areas, the inland and coastal wetlands

that fall under the jurisdiction ofthe Act, and establish presumptions of significance for each

resource area. These presumptions establish the interests of the Act that are supported by

each jurisdictional wetland type. Presumptions of significance are rebuttable upon a clear

showing, through the presentation of scientific evidence, that a wetland resource area functions

in a manner that is inconsistent with the presumptions in the regulations for that wetland type.

All jurisdictional inland wetlands except Isolated Land Subject to Flooding (ILSF) and portions

ofBordering Land Subject to Flooding (BLSF) are presumed significant to the protection of

wildlife habitat. ILSF is defined as "isolated depression or closed basin [wetlands] without

an inlet or an outlet" that, at least once a year, "confine standing water to a volume of at least

1/4 acre-feet and to an average depth of at least six inches." Since ILSF does not carry a

presumption of significance to wildlife habitat, it cannot be protected for the wildlife habitat

interest unless it is shown, by a preponderance ofevidence, that it is significant to that interest.

The official vernal pool certification program was originally developed to document cases

where ILSF and BLSF were functioning as vernal pool habitat, and therefore significant to

the protection ofthe wildlife habitat value protected by the Act. It is notable that in the years

since 1987, the NHESP has found no instance where an ILSF does not function as vernal

pool habitat.

In collaboration with biologists and regulators, the NHESP developed the official

vernal pool certification program. Criteria were established for the documentation of the

physical and biological characteristics ofvernal pool habitat consistent with the definition in

the regulations. The process typically involves volunteer effort in the documentation ofthe

physical and biological characteristics ofvernal pool habitat and submission to the NHESP
for review. If the vernal pool meets the requirements of the official Guidelines for the

Certification of Vernal Pool Habitat, the NHESP certifies the pool and notifies the local

conservation commission and the Massachusetts Department ofEnvironmental Protection's

(DEP) Regional Office. Biennially, theNHESP creates and distributes maps with the locations

of certified vernal pools for use by town conservation commissions, DEP staff, and project

applicants to be able to identify certified vernal pools during the permitting process.

The NHESP certifies any depressional area where vernal pool indicator species are

documented, provided that it holds water for at least 2 months during the spring and summer

ofmost years and is free of established fish populations. However, certification of a vernal

pool does not mean that the pool is automatically protected by the Wetlands Protection Act
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regulations; certified vernal pools are not themselves jurisdictional wetlands.

If a certified vernal pool does not occur within a wetland protected by the

Act, there is no jurisdiction over that pool, and the pool is therefore not

protected under the Wetlands Protection Act. However, when a certified

vernal pool falls within a jurisdictional wetland (e.g., ILSF or Bordering

Vegetated Wetland), the regulations protect the pool and up to 100 feet beyond

its boundary, referred to as the "vernal pool habitat." The vernal pool and

associated "habitat" must exist within the boundaries ofajurisdictional wetland;

no upland areas are protected under the Wetlands Protection Act (there is an

exception to this under the Rivers Protection Act, discussed below). The

NHESP defines the boundary of vernal pools, wherever they occur, as the

maximum observed or recorded extent of flooding in a confined basin

depression, or evidence ofthe same (e.g. leaf staining, etc.).

The regulations protect the wildlife habitat value ofa certified vernal

pool through general performance standards for proposed projects (310 CMR
1 0.57(4)(a)3 and (b)3). There is no threshold, or minimum size project, that

is presumed to have no impact on certified vernal pool habitat, and no alteration

ofvernal pool habitat is permissible that would "impair [the resource area's]

capacity to provide important wildlife habitat functions." Therefore, any project

that would alter a certified vernal pool must demonstrate that there would be

no substantial reduction in the pool's capacity to provide food, shelter, migratory

and breeding areas, and overwintering areas for amphibians, or food for other

wildlife. No changes to the topography, soil structure, plant community

composition and structure, or hydrologic regime are permissible if, after 2

growing seasons, the habitat functions listed above would be substantially

reduced.

Rivers Protection Act. The Wetlands Protection Act was again

amended in 1996 (originally proposed as a separate Act, the Rivers Protection

Act was ultimately passed as an amendment to the WPA), establishing a new

wetland resource area called the Riverfront Area that extends 200 feet from

the banks ofperennial streams. The regulations (revised 1997) for this new

resource area include specific protection for vernal pools, both certified and

not. Where a vernal pool within the Riverfront Area is certified prior to the

filing of a Notice of Intent, there is a strict performance standard that prohibits

any project that will have any adverse effect on the wildlife habitat value ofthe

vernal pool. For vernal pools that are not certified, yet are identified with

evidence from a competent source during project review, a project must have

"no significant adverse impact" on its ability to provide vernal pool habitat.
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Specific standards for uncertified vernal pools are a departure from the vernal

pool protection under the remainder ofthe Wetlands Protection Act regulations.

The Riverfront Area encompasses all lands within 200 feet ofperennial

streams. The wildlife habitat value of the entire 200 foot-wide Riverfront

Area may be protected under 310 CMR 10.58. Therefore, unlike the

protection provided to the wetland resource areas by the remainder of the

Act, the provisions for Riverfront Area allow protection ofthe important habitat

functions of uplands adjacent to vernal pool habitat. A growing body of

research indicates the tremendous importance of upland areas to wetland-

dependent wildlife populations (Burke and Gibbons, 1 995; Dodd and Cade,

1998; Semlitsch, 1998). Surrounding uplands provide critical non-breeding

habitat for animals that are largely terrestrial after completing their larval stage.

Both vernal pools and adjacent uplands that occur within the Riverfront Area

are protectable. Protection ofuncertified vernal pools and adjacent uplands

were important developments in the protection ofvernal pool habitat developed

under the Riverfront provisions of the Wetlands Protection Act. All vernal

pool habitat, certified or not, within the Riverfront Area is protected, as is the

associated upland, non-breeding habitat occurring within the 200 foot Riverfront

Area.

Surface Water Quality Standards. The current Massachusetts

Surface Water Quality Standards (3 14 CMR 4.00) were adopted in 1990 by

the DEP's Division ofWater Pollution Control to protect public health and

enhance the quality and value ofthe water resources ofthe Commonwealth.

The Standards implement the Massachusetts Clean Water Act (M.G.L. c.2 1

,

§26-53), "which directs the Division to take all action necessary or appropriate

to secure to the Commonwealth the benefits of the Federal [Clean Water]

Act. The objective of the Federal Act is the restoration and maintenance of

the chemical, physical and biological integrity ofthe Nation's waters" (3 14

CMR 4.01(4)). Before the US Army Corps ofEngineers may issue a federal

Clean Water Act permit for activities proposed in "waters ofthe United States"

(federal wetlands) that occur within the Commonwealth, a project must obtain

a 401 Water Quality Certification (314 CMR 9.09). 401 Water Quality

Certifications are issued by the DEP for projects that meet the requirements

of the Massachusetts Surface Water Quality Standards (314 CMR 4.00).

The Surface Water Quality Standards designate certified vernal pools

as Class B Outstanding Resource Waters (ORWs, 4.06(2)(a)). They are

protected by antidegradation provisions (314 CMR 4.04(3)) that prohibit any

new or increased discharge of pollutants. "No discharge of dredge or fill
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material shall be allowed to a [certified] vernal pool." (314 CMR
4.06( 1 )(d)( 1 1 )). These regulations relate directly to the federal Clean Water

Act. Therefore, the vernal pool must occur within a wetland under federal

jurisdiction, and the activity proposed must also trigger federal jurisdiction.

Similar to the Wetlands Protection Act, the protection provided by the Surface

Water Quality Standards end at the boundary ofthe jurisdictional wetland, in

this case a water of the United States, as determined by federal wetland

delineation standards.

Title 5. Title 5 ofthe Massachusetts Environmental Code (3 10 CMR
1 5.000) protects certified vernal pools by establishing minimum setbacks from

their boundaries for subsurface sewage disposal (septic) system components.

Septic tanks must be sited at least 50 feet, and soil absorption systems (leach

fields) and their reserves a minimum of 1 00 feet from the boundary ofa certified

vernal pool. The leach field setback may be reduced to 50 feet where an

applicant provides hydrogeologic data that demonstrates that the location of

the leach field is hydraulically down-gradient ofthe vernal pool.

The effective implementation ofthese regulations requires local boards

of health to check with their conservation commission for the locations of

certified vernal pools before permitting septic system plans. Title 5 only

protects vernal pools certified prior to application for septic system permits.

Forest Cutting Practices Act. The Forest Cutting Practices Act

regulations protect vernal pools from certain forest harvesting impacts, and

include protection for both certified and uncertified vernal pool habitat.

Harvesting around certified vernal pools is restricted to cutting no more than

50% of the basal area of trees within 50 feet of the pool. The regulations

require that no trees or tree tops be felled in vernal pool depressions and that

skidder trails not traverse them. They also prohibit their use as staging areas.

Vernal pools that have not been officially certified but are located by a service

forester may also be protected. The regulations contain guidelines for activities

around these pools that are similar to the requirements for forestry practices

performed near certified vernal pools.
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NHESP Potential Vernal Pool Metadata: Synopsis of

the PVP datalayer
-January 2001

OVERVIEW
This datalayer identifies the locations of potential, unverified, vernal pool habitat. Vernal pools are

small, shallow ponds characterized by lack offish and annual or semi-annual periods of dryness.

Vernal pool habitat is extremely important to a variety of wildlife species including some amphib-

ians that breed exclusively in vernal pools, and other organisms such as fairy shrimp which spend

their entire life cycles confined to vernal pool habitat.

Potential vernal pools visible on aerial photographs were interpreted and digitized on the MassGIS.

This datalayer does not include every vernal pool in Massachusetts. Many vernal pools have not

been identified due to unfavorable conditions in the landscape topography, pool physiography and/

or photograph quality. Furthermore, vernal pool habitat occurs in a wide variety of landscape

settings, including forested swamps, bogs, and other wetlands. Vernal pools within these settings

were not typically interpreted, but are nonetheless legitimate and valuable vernal pools. Also, field

verification of all potential vernal pools in this study will identify errors such as the inclusion of

features that are not actually vernal pools.

Potential vernal pools identified in this survey are not to be confused with Certified

Vernal Pools. Data pursuant to the official "Guidelines for the Certification of Vernal Pool

Habitat" must be collected in the field and presented to the Massachusetts Natural Heritage &
Endangered Species Program to obtain official certification for a vernal pool. Potential vernal

pools identified in this survey do not receive protection under the Massachusetts Wetlands Protec-

tion Act Regulations (310 CMR 10.00), or under any other state or federal wetlands protection

laws.

PRODUCTION
Potential vernal pools were identified from 1 : 12,000 scale, color infra-red (CIR), leaf-off aerial

photographs flown between late March and Early May. Statewide coverage included photos

taken in 1 993 (Bristol, Barnstable, Nantucket and Dukes Counties), 1 999 (Plymouth, northern and

southern Worcester, and eastern Franklin, Hampshire and Hampden Counties), and 2000 (Essex,

Middlesex, Suffolk, Norfolk, central Worcester, western Franklin, Hampshire and Hampden, and

Berkshire Counties). Using stereo pairs under a mirror stereoscope, the approximate centers of

pools were located. These points were digitized in a heads-up manner onto the MassGIS black

and white digital orthophotos at a scale of approximately 1 : 12,000.

ATTRIBUTES
The datalayer contains a field called Pvpid that identifies each Potential Vernal Pool by a unique

alphanumeric code. The digits correspond to the Town names in alphabetical order.

AVAILABILITY

This datalayer may be made available to EOEA agencies and EOEA cooperators for certain

projects. The legend that MUST accompany this datalayer on all maps is:

"NHESP Potential Vernal Pools: NOT equivalent to Certified Vernal Pools"
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Installing the MassGIS Runtime Data Viewer

PC System Requirements

Hard Drive: 40MB for Data Viewer software

RAM: 32 megabytes
Operating System Windows 95 or higher (including

CD-ROM drive

NT)

Note: Ifyou currently have a version ofthe MassGIS Runtime Data Viewer on

your machine, or ifyou have had it in the past and not completely removed it

(including anyprogram or data folders), this disk will not run properly. Instructions

for a complete uninstall are on page 25.

Step-by-step instructions

1

)

Close any programs that are running before running the installation

2) Insert CD into the CD-ROM tray

3) Determine the letter designation ofyourCD-ROM drive. You will need this after installing

the program when you run it for the first time. Ifyou are unsure ofthe letter designation for

the drive

a) Open Windows Explorer

b) Scan the list in the left window

for the CD-ROM icon. It should

be labeled with "Potentialvernalp

[drive letter]"

c) Make note ofthe drive letter

designation, and close Windows Explorer

A1F.

0\ Desktop

j§} My Computet

1 3H Floppy (A.
|

S _
H §> Private@FWE CPent 25@>Servers on 'StreetTalk

B g» Atev on 'StteetTalk\WorkGroup@FWE CPent 2E

[+: ^3 WorkGroup@FWE CPent 25@Setvets on 'Street

J Data

_J Gisdata

, 1 Program

|ji]_irrst32i.ex_

3_isdel

iji] sysl cab

\ji\ userl cab

|ji] data tag

•A datal cab

Re Folder

Re Folder

File Folder

284KB EX_Fie

8KB Application

201KB CAB Re

46KB CAB Re

1KB TAG File

1,553KB CAB Fie A

4) Click the Start button at the Windows Desk Top

5) Click Run...

6) Type E:\Setup.exe

Note, you must type the letter ofyour own CD-
ROM drive, as determined in step 3, above. It

may not be E as in this example

Type the name of a program., folder, document., or Internet

resource, and Windows will open it for you.

Open:

OK Cancel Browse..

7) Click OK
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Steps 8-11 refer to the dialog boxes that come up during installation

8) Welcome dialog box

Click Next

v.TitPnt m
& WateorMtortoMaitCir.fl'WwDateVww*

Sotuppforjarn JhrtpKnjarnv*lrnt«IMa»t<iiS

Runftiv at* Vt*nt# on your Computer

Matt lunnu tb* Setup program

CM. Car«.d lo QA Setup »rd Omti cfca« my prrjojariit you
havrj luvwg Cbok Nori to oortnue v*r> the Setup ptogiwn

WARNING Ttapirjrjamii proved r^eopyt^ law and
int«rftabond lieabet

Unauthorised leprodijrliona dafttxAon ot ttw program, or any

poUtonoU mwietv»«iiev»iflCrW«<]c(«T«.Jpef.*«w and

wi b* f«(.rncUrH to the m*amum intent porabiV undo law

9) Select Components dialog box

a) Be sure both boxes are checked

b) Confirm that Destination Folder is

on your hard drive and labeled

massgjs

c) Click Next

1 0) Select Program Folder dialog box

You will use the default "MassGIS

Runtime Data Viewer." Click Next

zzzsFs^mm *j

Setup steady to Seacopyaio, the tew llyouwrantlorevrewrj

change any tutrix tick 8ec* rtyou«r©«rtwIi«le«thlhe

telttiaJ. drek NMfobogn copyiifjfltt

£tooj*m Fofcte*:.

E iptikyj PoldJeW

Accessories

DeflAccecsonn
Del Documents
ESRI
Internet Explorer

Startup

f&SESP

11) Information dialog box

Click Next

t|M I C«d

Select Components

Select the components you want to install, clear the

components you do not want to install.

to MassGIS Runtime Data Viewer program files 32226 K

Ej MassGIS Runtime Data Viewer data tile-

m
Setup Summary

Setup component*

MastOS Runtime Data Viewer program file:

MatsfflS Rurtwe Data Viewer daiaHw

J

Program taiget dnectory

CiVnangrt

DataiatgetoVecioiy

CVnaagrs

Program rc*det

Mai.-GIS Runtime Data Viewer

J r
1

fix* j Hg*L Cancel

Copying will begin

1 2) ClickOKwhen installation is complete
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Starting the Data Viewer

Note: Thefirst time you start the Data Vieweryou will be prompted to enter the letter ofthe

CD-ROM drive (step 18). This tells the program where to lookfor files when it is

running. Ifyou enter the wrong drive letter, you will see an error message, and the

program will not run properly. If this happens you will need to entirely remove the

program and any folders it created, then repeat the installation procedure. Further

instructionsfollow the start-up procedure below.

1 3) Be sure the GIS Runtime Data ViewerCD is in the

CD-ROM drive. Click the Start button in Windows

14) Click Programs

15) Click on the MassGIS Runtime Data Viewer folder

16) Click on the MassGIS Runtime Data Viewer

program icon

1 7) The MassGIS Runtime Data Viewer will start

MASSGIS

Data
Viewer

MflsMchusetn Geographic Information System
1999 fxecutivt Oftictt of titvtroiirticntai Atfsiii

RMduva«v30tr>s2.Af,R.

JOjxJ

1 8) A dialog box will prompt you to enter the letter designation ofyourCD-ROM drive

« MassGIS Data Viewer

Type the letter ofyour drive and click

OK
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1 9) Ifyou type the wrong letter at this dialog box, you will see an error message

^Unexpected Condition

Did not find the shape directory

/|\ in either c:\massgi$\gisdata\

\!J or d:\gisdata\

Some data may not be available

| OK |

The program will not work properly until it has been removed entirely from the computer and

reinstalled. Ifyou get this error message,

a) Close the Data Viewer by clicking the small x in

the upper right hand corner

b) Select Yes when asked ifyou really want to quit

c) Click Start at the Windows Desk Top

d) Click on Settings

e) Select Control Panel

f) Double click the Add/Remove Programs icon

g) Scroll down to MassGIS Runtime Data Viewer and double click

h) Select Yes when prompted to confirm

file deletion

i) ClickOK when done This may

remove shared files in the process.

Select Yes when asked to confirm

j) Close Add/Remove Programs dialog

box

k) Close Control Panel

1) Open Windows Explorer

inflalAJnroMl ) VntkwwHT Soft*
]

AtWresS Ld Control Pyd
J5) drrrt

|

lwi«

I he loConmg iotiw«e C«n be sut<mate«l)> tfc'novtiJ by

Window* To K*rov« a wj&#* v to Mcdfci *- n:'wk<l

ccnpooenb . wfed*ft«!»thefaiindck*

Re^o^d SCSIAdaptwt
Settings

Telephony UPS

Ada/a««^« I

JCJJ<J|

Set* op proptrw end « J^MjCotapuUT

Locate the massgisfolder on the hard

drive (C) and manually delete it. This

is important - the reinstalledprogram will still not work ifthisfolder is not

removed

m) Close Windows Explorer

20) Repeat steps 1-18.

£l Exploring - (C:) W=in
File Edit View Go Favorites Tools Help n
Ad

All

dress |_> CA d
:ddeis X Name Size | Type *l

esklop ^ I
_|HPFonts File Fold"

B il My Computer LJI386 File Folder

^3H Floppy (A) _| l\J File Folder i

Fie Folder

File Folder —'

B & (C:) i_] Multimedia ...

O $oem$
1 J Piogiam Files

&LJ Backup USbpci File Folder

B L3 BMail USp4 File Folder

Cj Cdrom CjTemp FieFoMa
_| Dell »

LJ vines File Folder *|_ i
>r «l

1 ii
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Getting started

eL. r '

4&

77?e next 2 pages will provide a quick overview on how to zoom in to a particular town and

bring in the USGS topographic maps to the map thatyou are presented with on starting the

Data Viewer. You will also bring in the potential vernal pool datalayer into your view.

This isjust the beginning ofwhat the MassGIS Runtime Data Viewer is capable of. The CD
contains 5 lessons that were created by Shirley L. Griffin, Ed.D. These cover in more depth

the ArcView/Data Viewer interface, operation and manipulation of "Themes" in ArcView,

using theme tables and querying data, and making andformatting maps. After completing

installation, open Windows Explorer and open the \massgis\data\docs folder on the hard

drive. Examples 1-5 are labeled exlpic, ex2pic, etc. Double click to open in MS Word.

1 ) Open the MassGIS Data Viewer by following steps 13-17. You will only be asked to type

the letter ofthe CD-ROM drive the first time you open the program. You will be presented

with a map ofthe state (see page 24).

2) Zoom in to a specific town by clicking on the Z
button in the tool bar. Scroll down toMA Towns.

Double click, then select

a town from the list.

Tjinngham

Upton

Uxbridge

Initial Default

MA Counties

MA Legislative Districts

Cancel

Major Basins (Watersheds)

MDC Extents

PALIS Feature

Postal Villages / Neighborho d
Wales

Walpole

Waltham

Ware

J

3) Add datalayers to your view by clicking on the A button in the tool bar. Only a few ofthe

MassGIS datalayers were included on the enclosed CD. The available data will come up in the

list when you click theA button. For example, add the USGS topographic maps to your view

by clicking on the A button and double clicking USGS Topographic Maps. Repeat these steps

to add the Potential Vernal Pool datalayer to your view. You should be sure to zoom into a

relatively small area (e.g. one town); the topo maps will take a very long time to draw

otherwise.
Ljaa
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4) You will now see the potential vernal pool datalayer over the USGS topographic maps for

the part ofthe state you have displayed. Zoom in further by using the magnifying glass in the

tool bar. Either click on the area you want to see (zooming in gradually to the point that you

clicked) or click and drag a square around the area to zoom in quickly.

«,'
,iwwu.Wf«rffT

V' Pot*r>tulVt(ftj|Pook

VI MA Town Boundaikt

^ U80S Qu4<J Imjgs

<£:€

a
Use the hand tool to pan, moving the map in order to center a particular feature or to be sure to

include a road or building in the view that you'd like to be able to see.

There are a number ofother tools available for manipulating the maps,

measuring distances, zooming in or out to different extents, etc. See pages 26 -

43 for a broad introduction to the MassGIS Runtime Data Viewer and ArcView

environment, as well as the examples 1 - 5 contained on the program disk.

Ifthe potential vernal pools are added but not visible, look at the table ofcontents on the left

margin ofthe map. Make sure there is a line that says Potential Vernal Pools, that the small

check box to the left is checked (ifnot, just click on the box), and that it is at the top ofthe list.

Ifthat line is positioned below the topographic maps it will be covered by the maps in the view.

Click on the potential vernal pool line, holding the left mouse button down, and drag it to the top

ofthe table ofcontents.

This can be printed out, or can be brought into a Layout to add a legend, title, etc. See

Exercise 5, Making a Layout (Map), in the mass\data\docs\ex5pic.doc file on the CD.
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Introduction to ArcView

and the MassGIS Data Viewer

Courtesy ofthe MassGIS office. Some of

the topics and functions presented will not

apply to the Runtime Dataviewer, but are

presented as part ofthis general overview
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Background: GIS and Spatial Data

ArcView is one ofa number ofpowerful, easy-to-use geographic information system (GIS)

software applications. In the last few years, such applications have begun to provide non-technical

users the means to directly access sophisticated spatial analysis and mapping tools. ArcView (made by

Environmental Systems Research Institute, Inc. (ESRI), makers ofARC/INFO) is an interactive data

visualization and analysis tool. It is used to organize, explore, query, and map spatial data (information

referenced to locations defined by precise geographic coordinates). This capability is powerful, since an

estimated 80% ofdata used in business and government has a locational component.

Information that relates to such geographic units as addresses, ZIP codes, rivers, towns, and

regions is commonly gathered and stored in databases to be used for a wide range ofpurposes. What

has not been commonplace, however, is the ability to visualize and interpret these data in a manner

consistent with its spatial organization. More often than not, tables, charts, and statistics are produced

to list or summarize the data stored in spreadsheets or databases. While useful tools, these do not lend

themselves to easy interpretation when comparisons across areas and among multiple geographic units is

necessary.

This more complex data representation is the domain ofGIS. GIS software should be under-

stood as an enhanced database system that stores the actual geographic coordinate location ofdata

along with all the routinely stored descriptive or attribute information about the location. Special tools

are also included which utilize this coordinate information and allow for mapping and geographic analysis

ofthe data in addition to the traditional tables, charts, and statistics.

Purpose of this Document

This document is an introduction to the graphical user interface (GUI) and the basic data

visualization tools ofArcView Version 3.0a. It is by no means a comprehensive treatment of all

ArcView's features. It is designed to help a novice user to get up and running with the software and

includes instructions on how to use the extensive on-line help system which can serve as a further tutorial

and reference for the user motivated to learn more.

Also covered in this document is an explanation ofthe features ofa customized ArcView

project known as the MassGIS Data Viewer. This Viewer is available in three versions: one for those

who have a full copy ofArcView 3.0a, one for those who have a full copy ofArcView Version 2.1; and

another which includes a run-time version ofArcView for those who do not have a full copy ofArcView

Version 3.0a).

Although written for users ofthe MassGIS Data Viewer, this document can also be used by

those requiringjust an introduction to ArcView itself. In this case, the section on the MassGIS Data

Viewer can be ignored. In either case, it should be noted that this document is written based on the

Microsoft Windows version ofArcView and assumes the reader is familiar with working in the Win-

dows environment. However, the UNIX and Macintosh versions ofArcView are very similar and users

ofthose operating systems should also find this document useful.
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ArcView Basics

Graphical User Interface and Desktop Structure:

Like any typical Windows-based application, ArcView employs a graphical user interface

(GUI) as the framework for user interaction. As indicated in the figure below, this framework is con-

tained within the ArcView application window. The application window can be resized, rninimized,

maximized, and moved aroundjust like any other window.

ArcView Application window and Graphical User Interface (GUI)

File Edit View Theme Graphics Window Help
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The ArcView GUI consists ofthe following basic components:

The menu bar provides access to ArcView operations in a pull-down menu.

The button bar provides quick access to commonly-used operations also available from the

menu bar.

The tool bar accesses operations that are performed with the screen cursor. Each tool defines

a unique action for the cursor to perform.

The status bar displays a one-line description ofa menu choice, button, or tool, as the cursor is

moved over (without selecting) it. This is very useful as a help feature for determining the

function or purpose ofthe various menu, button, and tool options. The status bar also reports

measurements, displays system messages, and shows a progress bar for lengthy operations.

Document windows are the ArcView windows within which you perform your work. The four

GUI bars are context sensitive and reflect the options relevant to the active
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document window in which you are working at any given time. The active document window is

indicated by a highlighting ofthe window's top title bar. In the figure above, the window entitled

"View 1 " is active, and therefore, the menus, buttons, and tools showing are those pertinent to

this view document. The Project document window is a special window that manages the other

documents in the project (see next section).

ArcView Projects:

An ArcView project is a collection ofassociated documents that work together during an

ArcView session. Projects are stored in a single file with the ".apr" extension and provide an organized

way to manage the status ofthe various documents (views, tables, charts, layouts, and scripts) as you

work. Projects manage how and where documents are displayed, maintain current selections from the

documents, and define the appearance ofthe Application window.

The Project window contains a title bar with the name ofthe active project (e.g. proj 1 .apr in the

figure above) and acts as a gateway to the other documents in the project. Each icon in the Project

window represents a class ofdocuments. Clicking one ofthese icons "opens a gate" to documents of

that class. At any given time, there can be only one active project and hence, one Project window to

access and manage project components.

Opening. Saving and Closing your Project :

A project can be opened by double-clicking its name from the Windows File Manager. Alter-

natively, it is possible to set up an ArcView icon in Windows Program Manager that starts a specific

project by default when ArcView is started. IfArcView has been started without a default project (or if

the last project was closed), the ArcView File menu will provide the means to open a project. If, in

future sessions, you will be wanting to return to your project in the state in which you have developed it

in the current session, you should periodically save the project. Ifyou have made any changes to the

project, ArcView will give you the opportunity to save your project when you close it or exit ArcView.

Project level operations such as these are typically found under the File menu ofthe ArcView

GUI. However, exactly what can be accomplished from the File menu differs depending on the context

ofthe application and project:

When ArcView has been started without a default project (or ifyou just closed the project on

which you were working), the File menu contains:

New Project: Create a new project.

Open Project...: Open an existing project.

Exit: Exit ArcView.

With the Projectwindow active, the File menu contains:

New Project: Close and optionally save current project and create a new project.

Open Project...: Close and optionally save current project and open another project.

Close Project: Close and optionally save current project (does not exit ArcView).

Save Project: Saves the project in its current form.

Save Project As...: Saves the project in its current form as a different project name.

Extensions: . . . : Adds extra ArcView modules called extensions to the project.

Exit: Close and optionally save current project and then exit ArcView.
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With a non-Projectwindow (e.g. View) active, the File menu contains:

Close: Closes the current window in the project (not the project itself).

Close All: Closes all the windows in the project (not the project itself).

Set Working Directory: sets the default directory to save to.

Save Project: Same as when Project window active.

Print...: Brings up print dialog box.

Print Setup...: Brings up print setup dialog box.

Export...: Brings up table export dialog box.

Exit: Same as when Project window active.

Note that the project can also be saved by clicking the Save Project button (left-most button in the

Button bar with the floppy disk icon).

View Documents and Themes:

ArcView ViewWindow

Themes

Table ofContents

Map Display

yf\ Counties

A/
Massachusetts

i^^

*»V'

WsSk

A "view" is the primary document type which supports the interactive display and query of

spatial data organized into "themes". A "theme" can be thought ofas a reference to a database contain-

ing information about a particular set ofgeographic features with similar characteristics (e.g. roads,

towns, wells, etc.). A view defines the themes you use and how to display them, but it doesn't contain

the geographic data files themselves. Since the themes in the view only reference these source data files,

the view is dynamic because it reflects the current status ofthe source data. Ifthe source data changes,

a view that uses this data will automatically reflect the change the next time the view draws.

A view document is controlled by a view window which consists ofa map display area and a

table ofcontents (see figure above). The table ofcontents reflects the themes which are
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drawn in the map display area ofthe view. Furthermore, the view allows the user to manage how the

various themes are classified and symbolized according to the theme's legend. The process ofadding a

theme involves specifying where the spatial database you wish to display is located. In addition to the

native ArcView spatial data format, the spatial database formats supported by ArcView include: ARC/

INFO coverages and libraries; dBASE, INFO, and text files containing point location coordinates; and

various image formats.

View documents (like all other ArcView documents) are listed in and managed from the Project

window. To work with views, select the Views icon in the Project window, and then:

To open an existing view, double-click its name or select the view's name and click the Open

button.

To create a new view, click the New button. There can be more than one view in a project

(only one can be active at any given time) and each can contain any ofthe available themes.

To add a theme to a view, first make the view active (by creating or opening it, or clicking on

its title bar if it is already open). Then choose Add Theme from the View menu or click the Add
Theme button to display the Add Theme dialog box. Once a theme or themes are added they

can then be manipulated within the view (see following section).

Working with Themes in a View Window:

View GUI Buttons and Tools

Zoom Buttons

X tt r& ^ .'.:•

i * rQi&iaioBT •^d SJ
7 \

Identify Select Zoom
Features Features Tools

Pan Measure

Distance

There are two general classes ofoperations that can be performed on themes in a view: view-

specific; and theme-specific. An asterisk (*) following an operation's name indicates that the operation

can be performed via one ofthe buttons or tools from the view GUI illustrated in the figure above. The

other operations are accomplished by interacting directly with the view table ofcontents or via the view

GUI menus.
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View-specific operations (apply to all themes in the view):

Panning& zooming*: Use the Pan and Zoom tools and buttons to changed the size and

position ofthe map display. Panning repositions the focus ofdisplay without changing its scale.

Zooming in (or out) decreases (or increases) the scale ofthe display as it focuses on different

areas.

Measuring distance* : The Measure tool reports the accumulated distance between points

that are clicked in the view.

Theme-specific operations (apply to individual themes in the view):

Identifying features* : The Identify tool displays the attributes ofa specific feature in the

theme by clicking on it.

Selecting features*: The Select Feature tool selects a single feature in the theme by clicking

on the feature or selects many features at once by clicking and dragging a rectangular area

around the desired features. Certain operations can then be performed on selected features.

Making active: Clicking on a theme's name in the table ofcontents makes it active. When a

theme is active it appears raised off the table ofcontents, and is available for theme-specific

operations. Multiple themes can be made active by holding down the shift key while clicking.

Turning on and off: Clicking the check box in the table ofcontents for a theme toggles the

theme on and off. This is for display purposes only and is not the same as adding and deleting

themes.

Changing display order: ArcView draws themes sequentially starting with the theme at the

bottom ofthe table ofcontents. Each successively higher theme is drawn on top ofthe last. To

change the drawing order ofa theme, hold the mouse button over the theme in the table of

contents and drag the theme up or down to a new position in the list.

Editing Legends: Make a theme active and then choose Edit Legend from the Theme menu

or press the Legend Editor button, or double-click on a theme's name to bring up the Legend

Editor. From here a theme's symbolization and classification can be modified.

Deleting a theme: To delete a theme(s), make it (them) active and choose Delete Theme(s)

from the Edit menu.

Editing a theme: Only themes that have ArcView shape files as their data source can be

edited. To edit a shape file-based theme, make it active and choose Start Editing from the

Theme menu. Search Help for "editing a theme" for further information on native ArcView tools

for editing themes.

Note that there are other buttons, tools, and menu choices which interact with views which offer more

sophisticated ways ofaccomplishing some ofthe basic operations described here. Additional functions

not fully described in this document are also available. Remember: to get a briefdescription ofthe

purpose ofan icon button or tool, just move your cursor over it (without clicking) and read the status

bar. Also see the section on Using Help below.

m1* *
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Enhancing yourView:

For various purposes (e.g. titles, annotation) it may be desirable to add a short descriptive text

string to the view. To do this:

1

.

Select the "T" icon tool from the View document tool bar.

2. Click on the desired location for the text in the View display area. This will

bring up the "Text Properties" dialog box.

3

.

Enter the text in the box and click OK.

4. Double-clicking the text graphic object will bring up the "Text Properties" dialog

box again should the text (or other options in the dialog box) need to be edited.

5

.

To change the font, select Show Symbol Palette from the Window menu. This

will bring up the Palette Manager. Click on the ABC icon in the Palette Manager to

bring up the Font Palette, and then change the font properties as desired.

You may also want to experiment with the Label tool for labeling specific features, and the

Draw tool for drawing graphic shapes on the view.

Printing yourView:

There are a number ofways to print a view: the view display area can be printed alone; an

ArcView Layout can be used to include legend, scale and othermap composition elements; the

ArcView session window can be captured directly from the screen and then pasted into another pro-

gram for printing.

The way in which you print is also determined by the hardware platform on which ArcView is

ninning. For instance, when ArcView is running on the workstation, printing a view directly from

ArcView generally requires a postscript printer that is directly accessible on the network. For windows

platforms, you must make sure that the appropriate printer drivers are loaded and that you have se-

lected the appropriate printer. Ofcourse, regardless ofthe platform on which ArcView is ninning, ifthe

printers available are only black and white, the printed map may be difficult to interpret.

Using Help:

ArcView's on-line help system provides reference and "how to" information. Here's where

you'll find on-line topics that cover key concepts, step-by-step instructions, and context-sensitive help

for specific commands and dialog boxes. By clicking the highlighted text within Help, you canjump to

other topics related to the one you're reading.

To get a list of Help topics:

Choose Contents from the Help menu or press F 1

.

To get help on a specific menu item, button, tool, or document:

Click the Help button, then click the particular command, button, tool, or document.

To get help on a dialog box with which you're working:

Move the cursor to the dialog box and press F 1

.
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To search for Help on a specific topic:

1

.

Choose Search from the Help menu (or, ifHelp is already open, choose the Search button at

the top ofthe Help window) to bring up the Search dialog box.

2

.

In the uppermost box, type the first few letters ofa word or phrase relating to the topic you

want to search for. As you type, Help displays new words and phrases in the list box

directly below the one in which you're typing. You can back up ifyou've made a mistake or

select the phrase and replace it with other text.

3

.

Double-click the word or phrase related to your subject (or select it, and choose the Show

Topics button). The list box in the lower portion ofthe dialog box displays the relevant topics

for the word or phrase you selected.

4. In this lower list box, double-click the topic you want to go to (or select it, and choose the Go
To button).
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The MassGIS Data Viewer

BriefDescription:

The MassGIS Data Viewer is a customized ArcView project that uses the ArcView Avenue

object-oriented programming language. It consists primarily ofa few key enhancements to the native

ArcView view document GUI described above. These enhancements are designed to make it even easier

to work with spatial data (see below). The MassGIS Data Viewer was created specifically to be distrib-

uted and work with MassGIS data. However, it was also designed to be generic enough to work with

any other spatial data supported by ArcView.

Overview ofCustomization Approach:

The basic functionality ofnative ArcView described in the preceding sections is fairly straightfor-

ward. Nevertheless, there are a few areas that tend to present problems for the novice user and to prove

tedious for the more advanced users: the addition ofthemes to a view and their subsequent symbolization

and classification; and the ability to zoom to a specific location.

Adding themes requires some detailed knowledge about the structure, naming conventions, and

physical disk location ofthe source data files. On a stand-alone PC where one manages one's own data

this may not be a problem. However, in a networked environment, data may be stored and maintained

across multiple machines and multiple disks, all ofwhich tend to change periodically. This places an

overly cumbersome burden on the user to keep track ofall these "technical details". Furthermore, even if

one knows these details, having to constantly navigate up and down file paths, or having to type long path

strings becomes more than a minor inconvenience. Once a theme has been added, the process ofsym-

bolizing and classifying themes using the legend editor also becomes time consuming. Even ifa theme's

symbolization and classification is saved, the problem ofkeeping track ofdatapaths and file names for

these saved legend files recurs. Again, this problem may not be so severe ifthis were managed at a single

PC level.

Also, while the normal zoom tools are useful it is often desirable to be able to directly focus in on

a specific area. To get exactly where you want to be often requires multiple zooms and pans with the

view redrawing each time.

The MassGIS Data Viewer was designed specifically to address these and a couple ofother

minor limitations ofnative ArcView. However, it was decided that these enhancements should supplement

rather than replace the native ArcView functionality. So, the MassGIS Data Viewer is not a customized

project that has only a limited range ofutility. Everything you can do in native ArcView can be done in this

project as well. This approach allows novice users to slowly acquaint themselves with ArcView without

initially getting hung up by some ofits more difficult functions. The custom features described below are

integrated with the rest ofArcView in away that attempts to clearly distinguish the customized features

from the native features. It is expected that, initially, novice users will use primarily the customized fea-

tures. As they become more accustomed to working in ArcView, they can then gradually begin to explore

its many other features.
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Description of Specific Customizations :

The MassGIS Data Viewer customizations are primarily evidenced by the presence oftwo new

lettered buttons; various new choices at the top ofsome menus for the view document entitled "MassGIS

Data Viewer".

Some ofthe features ofthe MassGIS Data Viewer are disabled in the Runtime version ofthe

project. This is a limitation ofthe ArcView Data Publisher, which was used to create the Runtime version.

The disabled features appear in bold italics in the list below and on the Quick Reference page at the end

ofthis document.

(With the 12/29/97 release ofthe MassGIS Data Viewer for ArcView 3.0a, the "A" and "Z" buttons and

all the other Viewer customizations will work for all View windows that the user creates.)

Additional Buttons for a View document

Two new buttons can be found to the right ofthe normal view document buttons.

T"| The "A" button functions the same as the Add Inventory Theme menu choice described below.

The "Z" button functions the same as the Zoom to Specific Extent menu choice described below.

The "dog" button (to fetch an address) to the right ofthe query builder (hammer) but-

ton:

Address Match

Places a symbol on a TIGER street grid, on the correct side ofthe street, for an

address you specify. You can use this feature whether or not you know the zip code of

the address. (Note: Index files are needed for ArcView to do an address match and are created

for each town. ArcView will try to put the index files with the source data, ifthis directory is not

write-protected. Ifthe index files are saved with the data, the address matching script will be able

to reuse these files for any future address matching. However, is a good idea to have your data

write-protected. Ifthe directory is write-protected, the index files will be stored in the project's

working directory (look under the Project menu, the Properties choice). Ifthe index files are

saved in the working directory, they are only useful when the TIGER coverage remains in the

view. Once the TIGER coverage is removed from the view, these files are essentially useless.

The files will be named tig 1 .idx, tig2.idx, etc, so ifthey are in your working directory, you should

delete these files periodically. Also, the script will re-index the TIGER file ofa previously indexed

town ifthe user changes the input ofwhether they know the zip code ofthe address.)

» v2 ** *
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^ I The "scissors " button performs a cookie-cutter clip ofone theme on another. Suppose

that you wanted to find out how many miles ofroads were in a certain town. Since roads

do not stop at the town boundaries, you would have to use the town polygon as a cookie cutter

to cut out all the roads so that you could add up their length. To use this tool, highlight the

polygon or polygons that you want to use as the cookie cutter. Then make the theme active that

you want to be cut. Now, click on this button and answer the questions
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Additional Buttons for a Layout document

Make layout's Viewframe proportional to the View window.

The square button to the left ofthe printer button when a layout document is active.

Create a viewframe on the layout, and choose which view you want represented in it.

With the viewframe highlighted, click on this button. The viewframe's proportions should

change so they are equivalent to the view window's proportions.

Make a multicolumn legend

This tool leads you through the process ofmaking a legend in the layout that has more than one

column. You can also choose whether to represent your polygons as rectangles or ovals.

Place a graphic ofa table in the layout

Use this tool to draw a rectangle on your layout where you would like to place a table. Then,

follow the instructions to choose which table and which fields to use.

AdditionalVIEW Menu Choices

Resize View

Resizes the view based on computer's resolution and saves project

Zoom to Query

Sets the view extent to selected features in the active theme. Ifno features have been selected,

a standard Query dialog is presented, and the extent is set to the features that match the selec-

tion criteria.

Zoom to Specific Extent

Sets the view extent to the extent ofa specific area (either pre-defined or user-defined).

Choosing a zoom extent category from the first list brings up a second list from which the

specific area is then chosen.

User Extent Manager

Save and delete user-defined extents.

Choosing Save Current Extent prompts you to enter a name for the extent. This named extent

then becomes available under the User-defined Extents zoom category list accessed viaZoom
to Specific Extent described above.

Choosing Delete Saved Extent brings up a list ofall the saved user-defined extents. Picking one

will delete it from the list.

Add Inventory Theme

Add pre-defined themes to the view.

Choosing a theme category from the first list brings up a second list from which the specific

theme is then chosen. Making a choice here may actually bring up more than one theme at once

(e.g. Choosing Roads from the Infrastructure category will add both the Highways and Roads

themes to the view).

Reset the Project

Update the Theme and Zoom Inventories and clear the View.

This should be done when changes are made to tables that normally load when the Viewer is

first installed. There are two levels ofupdate: Inventory and Reset View:
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Update Theme & Zoom Inventories updates the choices available through Add Inventory

Theme and Zoom to Specific Extent

Reset View and Update Inventories updates the inventories and clears the Viewer window,

deleting all the themes and zooming to the default extent.

Overview

Create a small overview window to control and display the extent ofthe view.

This window displays one theme from the MassGIS Data Viewer view, along with a red rect-

angle showing the current extent ofthe Viewer view. Draw a new rectangle in the Overview

window, or drag the existing rectangle to change the Viewer extent.

Read/Write Graphics ODB file

Writes graphics out to anODB file, or reads them into the project from an ODB file.

This can help you get your graphics from one project to another.

Additional THEME Menu Choices

Describe

Brings up a box with information (including field descriptions and codes when available) on the

active theme.

Change Symbolization

Changes the legend ofthe active theme to another pre-defined legend. Choose from the list

presented. Ifonly one choice is presented (that ofthe current legend), there are no alternate

pre-defined legends for the theme.

Make Subset

Creates a new theme containing only selected features in the active theme. Ifno features have

been selected, a standard Query dialog is presented, and the new theme contains only features

meeting the criteria entered.

Make Buffer

Creates a buffer around a line or around or inside a polygon for the active theme. The resulting

buffer is a graphic.

Additional EDIT Menu Choices

Copy/Save/Restore Document

Saves and restores documents to ODB files. You can save your Views, Layouts, and other

documents out into ODB files which are separate from the project.

Registration

Advancedfeature: available on computers connected to an Arclnfo server (see the "MassGIS

Data Viewer Developer Reference "for instructions on configuring an Arclnfo server).

Register, or "geo-reference", an image (such as a scanned map) to the coordinate system ofthe

MassGIS Data Viewer view. A registered image can be displayed along with other data in the

Viewer view.

Make Annotation

Write a file to create Annotation in Arclnfo based on text in the view.
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Opening the MassGIS Data Viewer:

Opening sav30mg2.apr is just like opening any other ArcView project. However, certain things

happen during startup unique to this project. The first time sav30mg2.apr is opened, a number of

initialization procedures are run that set up the default project (creates the "MassGIS Data Viewer"

view, and puts up a default theme or themes at a certain default extent). These are the same procedures

that are run when you choose Reset Project from the View menu ofthe "MassGIS Data Viewer" view.

What happens during subsequent project startup depends on how the project was saved the previous

time (see next section).

Closing the MassGIS Data Viewer:

In general, closing sav30mg2.apr is just like closing any other ArcView project. Again, certain

things happen during shutdown unique to this project. Ifthe project has been modified (such as adding

themes, moving windows, or creating new documents) in your first session, upon closing the project,

you will be prompted to save itjust like in native ArcView. Choosing yes will cause the project to be

saved in its modified state. The next time you open the project the initialization procedures will be

bypassed thereby returning to the saved modified state. Choosing no will cause the project to return to

its original state. Re-initialization will then occur the next time the project is opened.

As noted, once the project has been saved with modifications reinitialization will no longer

occur. However, in certain situations (such as when there are multiple users ofthe project working with

different themes), it may be desirable to force a reinitialization upon startup. This is when you don't

want to save your current session and you don't want the last session to be saved either. To force a

reinitialization, first delete the "MassGIS Data Viewer" view document from the Project window. Then

save when you close the project. The next time the project is opened, initialization will occur. Of
course, the project can be reinitialized at any time by choosing Reset Project from the View menu ofthe

"MassGIS Data Viewer" view.
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Typical MassGIS Data Viewer Sessions:

A. Viewing data around a site

The following steps are recommended to view data around a particular site:

1

.

Open the MassGIS Data Viewer project.

2. Make sure the "MassGIS Data Viewer" view is active (click on it).

3

.

Zoom to the rough area which you are interested in viewing by using the ' 'Z' ' button or the Zoom
to Specific Extent menu choice from the View menu.

4. Add some themes to the view via the "A" button or the Add Inventory Theme menu choice

from the View menu. As themes are added it is suggested to further zoom and pan (using the

regular ArcView zoom and pan tools) to the smallest area possible which still covers the area in

which you are interested. Ifmany themes are added to a view covering a large extent, the time

for the view to redraw whenever the view changes can become very long. Zooming in first will

minimize this time. Also, it is advisable to delete any themes that are not needed. Another

option is to turn offcertain themes (by unchecking them in the table ofcontents) until you finally

focus in on the area in which you are interested.

5

.

Add any additional themes to complete the view.

6

.

Ifyou are zoomed in to an area extent to which you will likely be returning at some future point,

you should use the User Extent Manager from the View menu to save the extent. This will

facilitate returning to this precise area later.

7. Close the project (see section above).

B. Adding and editing features in shape-file themes

The following steps are recommended to add (digitize) features to and edit a shapefile theme:

1

.

Zoom to the appropriate area and put up the necessary themes (see A. above).

2

.

Make the intended shapefile theme active by clicking on it in the view table ofcontents.

3

.

Select Start Editing from the Theme menu. The theme's check box in the view table ofcontents

will then have a dashed outline to indicate that the theme is in digitize mode.

4. To add a new shape to the theme:

a. Click-and-hold on the Draw tool (rightmost icon in the view tool bar). The Draw tool is

a pull-down tool from which you select the type ofshape you want to draw. Its icon is

the currently selected shape (along with a small black

mark in the lower right corner indicating its pull-down Draw tool pull-down options

nature). The possible shapes are point, two-point line,

multi-point line (polyline), rectangle, circle, and irregular

polygon. Only shapes which create the feature type of

the shape theme you are editing can be drawn. For

example, ifyou are editing a shapefile made up of

polygons, only rectangles, circles, and irregularpolygons

can be drawn.

b.

O

Point

Two-Point Line

Multi-Point Line

Rectangle

Circle

Irregular Polygon

Use the mouse to delineate the feature in the view.

The way in which this is done depends upon the specific draw tool: for points, click

once; for two-point lines, click once for the starting point and once for the ending point;

for multi-point lines and irregular polygons, click once for each vertex,

*&
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double-clicking the last vertex to indicate the shape is complete; for rectangles and

circles, click and drag, releasing when the shape is the desired size,

c. After the shape is drawn, a data entry window will appear. Enter the appropri-

ate attribute information for this shape and click OK. Clicking cancel will save the

default attribute information (it will not delete the shape).

5. To edit existing shapes in the theme:

a. Select the Pointer tool.

b. Click on the shape you want to edit. Selection handles (8 solid black squares)

will appear at the extent ofthe selected shape feature.

You can move the shape when you see the double-headed cursor. Click-drag

the shape and drop it in the desired location.

To stretch or shrink the entire shape, grab one ofthe selection handles and

drag in the appropriate direction.

To reshape the shape, move its vertices. Clicking on the selected shape will

clear the selection handles and cause the vertex handles to appear at each ofthe shape's

vertices. Reshape the shape by moving the mouse until the cursor appears as a

crosshair on the vertex you want to reposition. Click-drag the vertex to the new

position.

To delete the shape, choose Delete Graphics from the view Edit menu. Note

that the Cut Graphics and Copy Graphics can be used like normal cut and paste tools.

c. Note that there are some more advanced editing techniques. Search Help for

"merge operations" and "snapping" formore information.

6. Select Stop Editing from the view Theme menu to get out ofdigitizing mode. Ifyou want to edit

another theme, you must first choose Stop Editing on the current theme and then start again

from Step 2.
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Summary of Other Advanced ArcView Features

The following are some ofthe key tasks you can accomplish with ArcView that have not been

discussed to this point:

- Display tabular data on a view.

- Import tabular data and thenjoin it to the data in a view to display it geographically.

- SQL to retrieve records from a database and display them on a view.

- Geocode tables containing addresses and display them.

- Select features according to their attributes (attribute queries).

- Select features based on their proximity to other features (theme on theme queries).

- Find places where certain features coincide.

- Summarize and generate statistics on the attributes offeatures.

- Create charts showing the attributes offeatures.

- Lay out a map and print it.
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MassGIS Data Viewer Quick Reference
Information on ArcView is available via the Help menu. This reference sheet lists the additional features available in

the MassGIS Data Viewer view. These features are described in more detail starting on Page 11 of Introduction to

ArcView and the MassGIS Data Viewer. Features that are disabled in the Runtime version appear in bold italics.

ActionalVIEW Buttons

The "A" button functions just as the Add Inventory Theme menu choice described below

I

z
I The "Z" button functions just as the Zoom to Specific Extent menu choice described below

^
I I

The "dog" button fetches an address and places a symbol on the TIGER street grid

jt»
1

The "scissors" button performs a cookie-cutter clip ofone theme on another

Additional VIEW Menu Choices

Resize View

Resizes the view based on computer's resolution and saves project

Zoom to Query

Sets the view extent to selected features in the active theme

Zoom to Specific Extent

Sets the view extent by choosing from a menu of pre-defined and user-defined choices

User Extent Manager

Save and delete user-defined extents.

Add Inventory Theme

Add themes to the view by choosing from a menu of pre-defined choices

Reset the Project

Update the Theme and Zoom Inventories and clear the View

Create/Delete Overview

Creates/deletes a small overview window to control and display the extent of the view

Read/Write Graphics ODBfile

Writes graphics out to an ODB file, or reads them into the project from an ODB file

AdditionalTHEME Menu Choices

Describe

Displays information (data source, field descriptions, etc.) on the active theme(s)

Change Symbolization

Changes the legend of the active theme to another pre-defined legend

Make Subset

Creates a new theme containing only selected features in the active theme

Make Buffer

Creates a buffer around a line or around or inside a polygon

Additional EDIT Menu Choices

Copy/Save/Restore Document
Saves and restores documents to ODB files

Registration Advancedfeature: available on computers connected to an Arclnfo server

"Geo-reference" an image to the coordinate system ofthe MassGIS Data Viewer

Make Annotation

Write a file to create Annotation in Arclnfo based on text in the view

Additional Layout Document Buttons / Tool

Make layout's Viewframe proportional to the View window

Make a multicolumn legend

Place a graphic ofa table in the layout
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Vernal Pool Fact Sheet
What are Vernal Pools?

Vernal pools are temporary bodies offresh water that provide critical habitat formany vertebrate and invertebrate wildlife

species. "Vernal" means spring, and indeed, many vernal pools are filled by spring rains and snowmelt, only to dry up

during the hot, dry months ofsummer. However, many vernal pools are filled by the rains ofautumn and may persist

throughout the winter. Vernal pools are quite often very small and shallow; vernal pools that support rich communities of

vertebrate and invertebrate animals may measure only a few yards across. However, vernal pools ofseveral acres occur

throughout Massachusetts.

Where are Vernal Pools Found?

Vernal pools are common in Massachusetts, occurring in every town in the state. Vernal pools are found across the

landscape where small woodland depressions, swales or kettle holes collect spring runoffor intercept seasonally high

groundwater tables. Although many people associate vernal pools only with dry woodland areas, vernal pools also occur

in meadows, river floodplains, interdunal swales, and large vegetated wetland complexes. Vernal pool habitat occurs

wherever water is contained for more than 2 months in the spring and summer ofmost years and where no fish are present.

Why are Vernal Pools Valuable?

Some state-listed species that may be found in vernal pools

Species
Blue-spotted salamander (Ambystoma laterale) 2

Jefferson salamander {Ambystoma jeffersonianum) 2

Marbled salamander (Ambystoma opacum) 2

Four-toed salamander (Hemidactylium scutatum) 3

Eastern spadefoot toad (Scaphiopus holbrookii) 2

Spotted turtle (Clemmys guttata) 3

Wood turtle {Clemmys insculpta) 3

Blanding's turtle (Emydoidea blandingii) 2

Status 1

sc
sc
T
SC
T

SC
sc
T

Vernal pools constitute a unique and increas-

ingly vulnerable type ofwetland. Vernal pools

are inhabitedbymany species ofwildlife, some

ofwhich are totally dependent on vernal pools

for their survival. Vernal pools do not sup-

port fish because they dry out annually or at

least periodically. Some may contain water

year round, but are free offish as a result of

significant drawdowns that result in extremely

low dissolved oxygen levels. The wood frog

(Rana sylvatica) and the four local species

ofmole salamander {Ambystoma spp.) have

evolved breeding strategies intolerant offish

predation on their eggs and larvae; the lack of

fish populations is essential to the breeding success ofthese species. Other amphibian species, including the American toad

(Bufo americanus), green frog (Rana clamitans), and the red-spotted newt (Notophthalmus viridescens), often exploit

the fish-free waters ofvernal pools but do not depend on them. Vernal pools also support rich and diverse invertebrate

faunas. Some invertebrate species, such as fairy shrimp (Eubranchipus spp.), are also entirely dependent upon vernal

pool habitat. Invertebrates are both important predators and prey in vernal pool ecosystems. Vernal pools are an impor-

tant habitat resource for many birds, mammals, reptiles and amphibians, including many state-listed rare species.

1 Status pursuant to the MA Endangered Species Act - T: Threatened;

SC: Special Concern
2 Obligate species require vernal pool habitat to successfully breed
3 Facultative species may use vernal pools but do not require them
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Vernal Pool Protection

The Massachusetts Wetlands Protection Act Regulations (3 10 CMR 10.00), the Massachusetts Surface Water

Quality Standards (3 1 4 CMR 4.00) used to administer section 40 1 ofthe federal Clean Water Act, the Massachusetts

Environmental Code: Title 5, and the Forest Cutting Practices Act regulations all provide protection to vernal pools that

have been officially certified. The regulations for both the Wetlands Protection Act and Forest Cutting Practices Act also

provide protection to vernal pools that have not been certified iftheir occurrence is adequately documented during permit

review. Protection under any ofthese laws requires the following:

1) the vernal pool occurs in an area subject to the jurisdiction ofthe regulations; and

2) the activities proposed are regulated.

The Massachusetts Wetlands Protection Act regulations (310 CMR 10.00) protect certified vernal pools and

up to 1 00 feet beyond the boundary ofthe pool (referred to as the "vernal pool habitat"), by preventing alterations which

would result in the reduction ofthe wildlife habitat value ofthe certified vernal pool. A certified vernal pool is not automati-

cally protected by these regulations, though. Certified vernal pools must occur within a resource area that comes under the

jurisdiction ofthe Act before they receive protection. Similarly, the 1 00 feet around the vernal pool does not extend into

non-jurisdictional upland or the buffer zone ofa resource area. Though the regulations specify performance standards for

vernal pools that are located in Bordering or Isolated Land Subject to Flooding (BLSF and ILSF respectively), vernal

pools that occur within any wetland resource area are protected for their wildlife habitat value under the Wetlands Protec-

tion Act. Performance standards may be applied by a conservation commission to protect vernal pools that occur in any

jurisdictional wetland resource area.

Vernal pools that are not certifiedmay also be protectedby a local conservation commission or the DEP ifcredible

scientific evidence is presented up until the end ofthe appeals period for a Superseding Order ofConditions issued by the

DEP. A conservation commission, or the DEP on appeal, can incorporate protective conditions into an Order ofCondi-

tions that would prevent the alteration ofthe wildlife habitat value ofthe pool and its 1 00 foot "vernal pool habitat" ifthey

occur within a regulated wetland even though it is not certified.

EachDEP Regional Office has at least one Vernal Pool Liaisonwho should be contacted for all questions related

to the protection ofboth certified and uncertified vernal pools. Since regulatory authority rests with the Department, they

are best able to answer questions about whatmay ormay not happen in or around vernal pools. Your regional liaison may

be reached at the following addresses:

Northeast Regional Office Southeast Regional Office

Wayne Lozzi Daniel Gilmore

203-A Lowell Street 20 Riverside Drive

Wilmington,MA 01887 Lakeville,MA 02347

(978) 66 1 -7600 (508) 946-2700

Central Regional Office Western Regional Office

Marielle Stone Karen Hirschburg

627 Main Street State House West, 4th Floor

Worcester, MA 01608 Springfield,MA 01 103

(508) 792-7650 (413) 748-1 100

50



The Massachusetts Surface Water Quality Standards (314 CMR 4.00) administer Section 401 ofthe federal

Clean Water Act and protect certified vernal pools. Under these regulations, any certified vernal pool is classified as an

Outstanding Resource Water (ORW). The regulations, administered by the DEP, strictly prohibit discharges of solid or

liquid fill within certified vernal pools. Storm drainage from roads and rooftops as well as solid fill are prohibited within

the boundaries ofthe pool. As is the case with the Wetlands Protection Act however, the certified vernal pool as well

as the proposed activity must be within thejurisdiction ofthese regulations - the state's Clean Water Act - before it

receives this protection.

The Massachusetts Environmental Title 5 (310 CMR 15.000) regulates the siting and construction ofsubsurface

sewage disposal (septic) systems in the state. A system's septic tank and distribution box must be located a minimum of50

feet, and the leaching field a minimum of 1 00 feet, from the boundary ofa certified vernal pool.

The Massachusetts Forest Cutting Practices Act Regulations (3.04 CMR 11.00) protect certified vernal

pools from certain forestry impacts. Harvesting requirements limit cutting to no more than 50% ofthe trees within 50 feet

ofa certified vernal pool. They also require that trees or tree tops not be felled in certified vernal pools, and restrict the use

ofpools as staging areas or skidder trails. Guidelines, similar to the regulations, are established for activities planned near

uncertified vernal pools identifiedby consulting foresters.

The Vernal Pool Boundary

The extreme edges of vernal pool habitat represent one of the most ecologically valuable portions of these habitats.

Shallow water at the edge ofa pool is generally the first to thaw in the spring. This provides early access to the pool for the

earliest breeding species. The shallow water zones also tend to be significantly warmer than the deeper portions ofa vernal

pool throughout the spring. Egg masses ofearly breeding amphibians benefit from the warmer water temperatures at the

pool edges that promote rapid egg development.

The boundary ofvernal pool habitat must incorporate the shallowest reaches ofthe pool. Where there is no distinct and

clear topographic break at the edge ofa pool, the maximum observed or recorded water level represents the ecological

boundary ofthe vernal pool. This boundary is evident and should be delineated by leafstaining and other indicators of

;

hydrology outside ofthe peak-flood stage ofearly spring (March through early April in most cases).

*PLEASE NOTE* The boundary ofvernal pool habitat may be defined differently for the purpose of state or federal

protection.

Thephysical, on-the-ground, boundary ofa certified vernalpool is not established when a certification number
is issued. Field observations ofmaximum flood levels, or ofindicators ofthe maximum water level, must be made to

determine the boundary. The boundary must be established based on field observation ofwater level indicators. The

NHESP, in certifying a vernal pool, does not visit the pool, and as such does not establish the actual boundary through the

certification process. Therefore, in recording observations ofvernal pools for the purpose ofcertification, notes pertaining

to observed water level and recognizable landmarks that show maximum flooding are extremely helpful in boundary

delineation.

The Wetlands Protection Act regulations allows a project proponent to submit an opinion as to the extent ofa certified

vernal pool that is based upon a theoretical one year storm ofa total of2.7 inches ofwater in 24 hours. Ifan opinion based

on this theoretical storm event is to be submitted, it should also include ground water that the basin is holding at the

beginning ofthe spring amphibian breeding season. Calculations without groundwater inputs will under-represent the true

size ofthe vernal pool. The DEP has stated in its program policies that ground water inputs should not be ignored in these

calculations because it will result in a total volume thatmay be considerably smaller than the basin holds in any given spring.
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How Can Vernal Pools be Certified?

The Massachusetts Natural Heritage & Endangered Species Program administers the official vernal pool certification

program. The certification program depends entirely on volunteer effort and the initiative ofinterested individuals and

organizations Interested parties should locate potential vernal pools and then:

1

.

Contact the Massachusetts Natural Heritage & Endangered Species Program [(508) 792-7270, ext. 200 or

www.state.ma.us/dfwele/dfw/nhesp/heritage.htm] to obtain the official Guidelinesfor the Certification ofVer-

nal Pool Habitat, along with Vernal Pool Field Observation Forms;

Certification is based on proofthat a confined basin depression provides important wildlife habitat consistent

with the vernal pool certification criteria in the Guidelines. Animals that use vernal pools at some point in their

life cycle are generally divided into two groups:

Obligate Species: those vertebrate and invertebrate species that rely on vernal pools for all or a portion of

their life cycle and are unable to successfully complete their life cycle without vernal pools

Facultative Species: those vertebrate and invertebrate species that can use vernal pool habitat for all or a

portion oftheir life cycle, but are able to successfully complete their life cycle in other water bodies

Obligate species serve as direct indicators ofvernal pool habitat because they require at least two months of

flooded conditions and the absence ofestablished fish populations. When breeding evidence ofobligate species

is documented, it is not necessary to prove that an established, reproducing fish population does not exist.

Facultative species serve as indirect indicators ofvernal pool habitat. Therefore, ifonly facultative species are

observed, evidence that there is no reproducing fish population must also be submitted for certification.

2

.

Fill out and submit a Field ObservationForm along with photographic documentation ofthe physical and biological

criteria required by the Guidelines and required maps to theNHESP for review. Photographs (slides or prints)

are the preferred type ofdocumentation ofthe biological certification criteria observed in a vernal pool. The most

easily photographed evidence ofvernal pool indicator species is egg masses ofwood frogs and mole salamanders.

These are conspicuous in the early spring and easily distinguished from other amphibian eggs. See the Guidelines

for details.

Following receipt ofcertification materials, the Natural Heritage& Endangered Species Program assesses the complete-

ness and accuracy of the information and documentation submitted. The NHESP does not field visit pools prior to

certification but relies on the presentation ofaccurate and clear documentation.

After it is determined that a vernal pool meets the physical and biological criteria established in the Guidelines, it will be

officially certified by the NHESP. The observer, local conservation commission, regional office ofthe Department of

Environmental Protection and the landowner are notified ofthe certification. The locations ofcertified vernal pools are

plotted on the NHESP's "Estimated Habitats ofRare Wetlands Wildlife and Certified Vernal Pools" on a biennial basis.

These maps are sent to the town clerk and to the conservation commission, and are available for viewing by the public. The

NHESP also produces a statewide Atlas ofthese maps, reproduced at a reduced scale, which is available at cost. The

certified vernal pool datalayer is also available in digital format through the MassGIS office.
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CERTIFICATION CRITERIA

Please read and understand the DOCUMENTATION REQUIREMENTS in the next section before submitting

vernal pool certification applications.

Documentation ofthe biological and physical criteria described in this section is necessary to obtain official certification

ofany vernal pool.

DOCUMENTATION OF ANY ONE OF THE FOLLOWING (1-3) WILL CONFIRM THE EXIST-
ENCE OF VERNAL POOL HABITATAND IS SUFFICIENT FOR OFFICIAL CERTIFICATION

1) The Obligate Species Method
2) The Facultative Species Method
3) The Dry Pool Method

1) The Obligate Species Method

Evidence of a confined basin depression with no permanently

flowing outlet AND one or more ofthe following:

1A Breeding* Obligate Amphibian
Wood frog (Rana sylvatica)

Spotted salamander (Ambystoma maculatum)

Blue-spotted salamander {Ambystoma laterale)**

Jefferson salamander (Ambystoma jeffersonianum)**

Marbled salamander (Ambystoma opacum)**

Eastern spadefoot toad (Scaphiopus holbrooki)**

OR

IB Adult Obligate Invertebrate

Fairy shrimp (ANOSTRACA: Eubranchipus)

* Acceptable Breeding Evidence

Documentation ofany one of the following proves

that an area functions as vernal pool habitat. For the

purposes of official certification, if amphibian evidence

is submitted it must show evidence of breeding.

1

.

Breeding Adults

• Frogs and toads: breeding chorus and/or mated

pairs

• Salamanders: courting individuals (congressing)

and/or spermatophores

2. Egg Masses (two or more are required)

3. Larvae (tadpoles or salamander larvae)

4. Transforming Juveniles

• Frogs and toads: tail remnants evident

• Salamanders: gill remnants evident

** State-listed Species
State-listed Endangered (E), Threatened (T) and Special Concern (SC) species are protected under the Massachusetts Endangered

Species Act (321 CMR 10.60); fill out a Rare Animal Observation Form and submit along with Certification Form.
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CERTIFICATION CRITERIA
Continued

January 1, 2001

2) The Facultative Species Method

Evidence of a confined basin depression with no permanently flowing outlet AND evidence that there is no established,

reproducing fish population

AND photographs oftwoormore of the following:

AMPHIBIANS
Breeding* Spring peeper {Pseudacris crucifer)

Breeding* Gray treefrog (Hyla versicolor)

Breeding* American toad (Bufo americanus)

Breeding* Fowler's toad {Bufo woodhousii)

Breeding* Green frog {Rana clamitans melanota)

Breeding* Pickerel frog {Rana palustris)

Breeding* Leopard frog {Rana pipiens)

Breeding* Four-toed salamander

{Hemidactylium scutatum)**

Adult or Breeding* Red-spotted Newt

{Notophthalmus v. viridescens)

REPTILES
Spotted turtle {Clemmys guttata)**

Blanding's turtle {Emydoidea blandingii)**

Wood turtle {Clemmys insculpta)**

Painted turtle {Chrysemys p. pictata)

Snapping turtle {Chelydra serpentina)

INVERTEBRATES
Predaceous diving beetle larvae {Dytiscidae)

Water scorpion {Nepidae)

Dragonfly larvae {Odonata: Anisoptera)

Damselfly larvae {Odonata: Zygoptera)

Dobsonfly larvae {Corydalidae)

Whirligig beetle larvae {Gyrinidae)

Caddisfly larvae {Trichoptera)

Leeches {Hirundinea)

Freshwater (fingernail) clams {Pisidiidae)

Amphibious, air-breathing snails {Basommatophora)

3) The Dry Pool Method

Evidence of a confined basin depression containing no standing water (dry pool)

AND one or more ofthe following:

Cases of caddisfly larvae {Trichoptera)

Adults, juveniles or shells of either of the following:

Freshwater clams {Pisidiidae)

Amphibious, air-breathing snails {Basommatophora)

Shed skins (exuvia) of dragonfly or damselfly larvae on vegetation along the edge of pool
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DOCUMENTATION REQUIREMENTS

January 1, 2001

Documentation of the biological and physical characteristics listed in the

CERTIFICATION CRITERIA must be submitted for official certification of a vernal

pool. Photographic prints or slides are the preferred method of documentation, but

video tapes of evidence or audio recordings of calling frogs are acceptable. Field

notes are encouraged, but are not accepted as the sole source of evidence; they

must be submitted along with photographic or taped documentation.

The following field observations must be adequately documented

Label all photographs as follows:

Location of pool
(or your tracking number)

Date of photograph
Observer's name

1 . Biological criteria:

1A Clear photographs or video of obligate amphibian breeding evidence

OR

OR
IB Clear photographs or video of facultative invertebrate or vertebrate species (AND 2B or 2C)

1C Audio tape of frog breeding chorus

2. Fishlessness:

2A Evidence of obligate species per CERTIFICATION CRITERIA (1A above)

OR

OR
2B Photograph of dry vernal pool

2C Scientific evidence (e.g. seining) that documents the absence of fish

3. Physical criteria:

Clear photographs or video of the vernal pool demonstrating the lack of permanently flowing

connections to larger wetlands

MAPPING REQUIREMENTS

It is critical to provide maps that are accurate and clear when submitting information for state vernal pool certification. A
copy of a 1:24,000 or 1:25,000 scale U.S. Geological Survey topographic map is required, and additional maps that

clarify the position of the vernal pool must be submitted. There are many maps are acceptable for this purpose, but please

note that street maps generally are not. Supporting maps should provide more detail than the USGS topo map.

At least one from each of the following groups must be submitted:

GROUP 1

USGS topographic:

The location of the vernal pool must be

clearly and accurately marked with an

'X' or dot. Be sure to write down the

name of the map (found in the bottom

right-hand corner) on the copy sent in

GROUP 2

Aerial photograph

Large scale (1 : 12,000 or better) with pool clearly visible

Sketch map with compass directions and distances

Magnetic compass direction and distances from two permanent landmarks

within 1000 feet of the pool. Landmarks should be readily identifiable in

the field and clearly described on the submitted map
Professional survey or local 1- or 2-foot contour topographic map
Large scale topographic maps or project plans where the depression is

evident
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January 1, 2001

Examples of maps that can be submitted for certification. A USGS topographic map must
be submitted (please note the map name, found in the lower right and upper left corners

of the map), along with at least one additional map (see previous page for list).
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USGS Topographic map section

with pool clearly marked

yVJ Pool

Sketch map with com-

pass directions and

distance from landmarks

B&W copy of color

infra-red aerial photo-

graph ( 1 : 12,000 scale)

with pools visible or

clearly marked

Field Observation Form

Application for certification of vernal pool habitat should be made using the standard field observation form (revised in 1999).

All requested information should be filled out to the fullest extent possible. Additional directions are provided on the field form.

Please give particular attention to the following items:

Section 1: Written directions to the pool must be provided, noting field markers to help navigation.

Section 2: Please indicate the dates on which evidence was collected, including the year.

Section 3: Indicate the evidence of obligate and facultative species collected at each pool. If egg masses were found,

indicate the number of masses discovered.

Section 4 and 5: Check the boxes corresponding to evidence submitted for each pool (in photographs or tape)

Optional Information: Information provided in this section gives the Natural Heritage & Endangered Species Program a

better sense of the type of vernal pools that are being identified through the certification program, and aides in-field identifica-

tion of the pools should anyone need to visit it. This section is optional, but provides very helpful information.

Section 6: Field forms must be signed at the bottom of page 2.

Incomplete submissions will be returned in full with a letter indicating any missing information. When the requested informa-

tion has been collected, the application may be resubmitted.

Submit completed applications to:

Vernal Pool Certification

Natural Heritage & Endangered Species Program

Route 135

Westborough, MA 01581
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V*
Natural Heritage & Endangered Species Program

Massachusetts Division of Fisheries and Wildlife

Vernal Pool Field Observation Form
(For use with Guidelines for Certification of Vernal Pool Habitat)(7/99)

PVP

For office use only.

1. Pool location

Town County

USGS Quadrangle name

Written directions to pool:

series 7.5' X 7.5'

Z\ SERIES 7.5' X 15'

o
z w

i
S CD

s =>

O Ui

z
CD

<2 l-
x en

(Use additional pages, if necessary.)

2. Observation dates

Last date pool observed

First date pool/species observed

_ Last date species observed

3 A. Evidence: obligate amphibians indicate date of observation.

* = RARE SPECIES
COURTING
ADULTS

SPERMATOPHORES EGG
MASSES (2+)

SALAMANDER
LARVAE

TRANSFORMING
JUVENILES

SPOTTED

SALAMANDER

. BLUE-SPOTTED

SALAMANDER

# JEFFERSON

SALAMANDER

MARBLED*
SALAMANDER

UNIDENTIFIED MOLE

SALAMANDER

BREEDING
CHORUS

MATED
PAIRS

EGG
MASSES (2 + )

FROG
TADPOLES

TRANSFORMING
JUVENILES

WOOD FROG

* SPADEFOOT TOAD

Instructions
for complete information about

certification, refer to guidelines for
certification of vernal pool habitat.

Provide all of the information

REQUESTED IN BOXES 1-6. If MORE SPACE IS

REQUIRED, ATTACH ADDITIONAL PAGES. INCLUDE

ALL REQUIRED PHOTOGRAPHS AND DOCUMENTA-

TION. Sign the form in the area provided on
the reverse side. incomplete or unsigned

submissions will be returned.

The following instructions refer to

each of the numbered boxes.

1 . The 7.5 X 7.5 series has the

legend "7.5 minute series" in the upper
right hand corner along with the

quadrangle name. the 7.5 x 15 minute

series is so labeled in the upper right

hand corner and has the quadrangle name
in the lower right corner.

Written directions must be included.

2 Indicate the first and last dates that

the pool or its biological components were
observed.

3. Part A and B are for certification

BY OBLIGATE SPECIES. PART C IS EITHER FOR
ADDITIONAL INFORMATION (APPRECIATED) OR FOR
CERTIFICATION BY THE FACULTATIVE SPECIES. IF

CERTIFYING BY OBLIGATE SPECIES, PROVIDE A

PHOTOGRAPH OF THE POOL HOLDING WATER AND
AT LEAST ONE PHOTOGRAPH (OR AUDIO TAPE FOR

CHORUSING) OF BREEDING ACTIVITY.

FOR CERTIFICATION BY FACULTATIVE SPECIES,

PROVIDE PHOTOGRAPHS OF THE POOL HOLDING

WATER AND PHOTOGRAPHS (OR TAPES) OF THE
FACULTATIVE SPECIES AS REQUIRED. ADDITION-

ALLY, PROVIDE A PHOTOGRAPH OF THE POOL
WHEN DRY OR OTHERWISE PROVE THAT IT HAS NO
FISH.

3 B. Evidence: fairy

shrimp
DATE OBSERVED

O O. tVIClenCe: TaCUltatlVe OrganiSmS Two or more must be documented. Indicate date of observation.

* = RARE SPECIES
DATE

OBSERVED ACTIVITY OBSERVED DATE
OBSERVED ACTIVITY OBSERVED

BREEDING
SPRING PEEPERS

PAINTED TURTLES

BREEDING
GRAYTREEFROGS

SNAPPING TURTLES

BREEDING
GREEN FROGS

PREDACEOUS DIVING

BEETLE LARVAE

BREEDING
LEOPARD FROGS

WATER SCORPIONS

BREEDING
PICKEREL FROGS

DRAGONFLY NYMPHS

breeding
American toads

DAMSELFLY NYMPHS

breeding
fowler's toads

DOBSONFLY LARVAE

^ breeding four-toed
salamanders

WHIRLIGIG BEETLE
LARVAE

RED-SPOTTED
NEWT (ADULTS)

CADDISFLY
LARVAE

* SPOTTED TURTLES LEECHES

* WOOD TURTLES FINGERNAIL (FRESHWATER)
CLAMS

* BLANDINGS TURTLES AMPHIBIOUS AIR-BREATHING
SNAILS



Instructions (continued)

4. Indicate the photographs being

submitted. label, date, and sign all photos.
5. Mark the pool clearly on all maps. The

pool must be clearly distinguished from other
wetlands and be locatable by others. provide
any maps that would help someone unfamiliar

with the area locate the vernal pool in the

FIELD.

6. The form must be signed. Unsigned
submissions will be returned without further
ACTION.

Optional information:

Property owner. Provide information about
PROPERTY OWNER(s), IF KNOWN. It IS RECOMMENDED
THAT YOU SEEK PROPERTY OWNER PERMISSION PRIOR

TO CERTIFICATION ACTIVITIES.

Rare species. A photograph is necessary
for documentation of rare species habitat.

Description. Provide any information that

will distinguish the pool from other wetlands
(boulders, debris, tree species, etc.).

MUST BE LABELED,

DATED, AND SIGNED.Photographs
POOL HOLDING WATER

OBLIGATE +/OR FACULTATIVE SPECIES

DRY POOL (REQUIRED FOR EVIDENCE 3C)

5. Maps submitted

USGS TOPOGRAPHIC MAP (REQUIRED)

AND ONE OR MORE OF THE FOLLOWING:

AERIAL PHOTOGRAPH

SKETCH MAP WITH COMPASS DIRECTIONS AND

DISTANCES FROM LAND MARKS

PROFESSIONAL SURVEY

LARGE SCALE TOPO

OPTIONAL EXTRA INFORMATION

SKETCH MAP OF AREA

ASSESSOR'S MAP

GPS LONGITUDE/LATITUDE COORDINATES

Although the following information is not required for1
r\~*i:^~*~.\ :*-.£^~~-^~t-:^^ AimougnineTOllowmg intormation is not required I

CJptlOnal intOrmatlOn certification, it is useful toWOP tomiHf better
r protect the vernal pool, its habitat and species.

Property owner

Name

It is strongly recommended that landowner permission
be obtained prior to collecting certification
documentation.

Address

Town State ZIP

Rare Wetland Were ANY RARE STATE-LISTED SPECIES OBSERVED USING

THIS POOL?

species
[71 [nI ' S A PHOTOGRAPH OF THE RARE SPECIES INCLUDED WITH THIS^^ FILING?

Description of pool and surroundings

Dimensions: approximate length

APPROXIMATE DEPTH

APPROXIMATE WIDTH

Describe distinctive features (roads, structures, boulders, etc.) which are visible

from or near the pool.

Are there other distinctive features about this pool (vegetation types, abandoned vehicles, foot

trails, etc.) that would help someone recognize it?

6. Observer information & signature

Name

Address

Town State ZIP

Telephone

e-mail

I hereby certify under the pains and penalties of perjury that the information

contained in this report is true and complete to the best of my knowledge.

Signature Date

Send completed form and
supporting documentation to!

I 1

|

NH&ESP
|

!

Vernal Pool Certification

MA Division of Fisheries & Wildlife
; Route 135

I
Westborough, MA 01581 I

I I

All submissions and

supporting documents will be

retained by the Natural Heritage

& Endangered Species Program.

Information submitted on this

form and other documents is

part of the public record and is

available to interested parties

under the State Documents

Request Law.



^^ Natural Heritage & Endangered Species Program
Massachusetts Division of Fisheries and Wildlife

kj§ Vernal Pool Field Observation Form
^H* » (7/99) (For use with Guidelines for Certification of Vernal Pool Habitat)

1. Pool location

Town County

n series 7.5' X 7.5'

USGS Quadrangle name series 7.5" x 15'

Written directions to pool:

o
Z UJ

£ m
2 D
O cn

| HI
£ UJ

in t-

* i

(Use additional pages, if necessary.)

2. Observation dates

Last date pool observed

First date pool/species observed

Last date species observed

3 A. Evidence: obligate amphibians indicate date of observation.

* = RARE SPECIES
COURTING
ADULTS

SPERMATOPHORES EGG
MASSES (2 + )

SALAMANDER
LARVAE

TRANSFORMING
JUVENILES

SPOTTED

SALAMANDER

^ BLUE-SPOTTED

SALAMANDER

^ JEFFERSON

SALAMANDER

^ MARBLED
SALAMANDER

UNIDENTIFIED MOLE
SALAMANDER

BREEDING
CHORUS

MATED
PAIRS

EGG
MASSES (2+)

FROG
TADPOLES

TRANSFORMING
JUVENILES

WOOD FROG

* SPADEFOOT TOAD

Instructions
for complete information about

certification, refer to guidelines for
certification of vernal pool habitat.

Provide all of the information

REQUESTED IN BOXES 1-6. If MORE SPACE IS

REQUIRED, ATTACH ADDITIONAL PAGES. INCLUDE

ALL REQUIRED PHOTOGRAPHS AND DOCUMENTA-

TION. Sign the form in the area provided on
the reverse side. incomplete or unsigned

submissions will be returned.

The following instructions refer to

each of the numbered boxes.

1 . The 7.5 X 7.5 series has the

legend "7.5 minute series" in the upper
right hand corner along with the

quadrangle name. the 7.5 x 15 minute

series is so labeled in the upper right

hand corner and has the quadrangle name
in the lower right corner.

Written directions must be included.

2 Indicate the first and last dates that

the pool or its biological components were
observed.

3. Part A and B are for certification

BY OBLIGATE SPECIES. PART C IS EITHER FOR
ADDITIONAL INFORMATION (APPRECIATED) OR FOR
CERTIFICATION BY THE FACULTATIVE SPECIES. If

certifying by obligate species, provide a

photograph of the pool holding water and
at least one photograph (or audio tape for

chorusing) of breeding activity.

For certification by facultative species,

provide photographs of the pool holding

water and photographs (or tapes) of the

facultative species as required. addition-

ally, provide a photograph of the pool
when dry or otherwise prove that it has no
FISH.

3 B. Evidence: fairy

shrimp
DATE OBSERVED

O w. tVIQenCe. TaCUltatlVe OrganiSmS Two or more must be documented. Indicate date of observation.

* = RARE SPECIES
DATE

OBSERVED ACTIVITY OBSERVED DATE
OBSERVED ACTIVITY OBSERVED

BREEDING
SPRING PEEPERS

PAINTED TURTLES

BREEDING
GRAY TREEFROGS

SNAPPING TURTLES

BREEDING
GREEN FROGS

PREDACEOUS DIVING

BEETLE LARVAE

BREEDING
LEOPARD FROGS

WATER SCORPIONS

BREEDING
PICKEREL FROGS

DRAGONFLY NYMPHS

breeding
American toads

DAMSELFLY NYMPHS

breeding
fowler's toads

DOBSONFLY LARVAE

^ BREEDING FOUR-TOED
SALAMANDERS

WHIRLIGIG BEETLE
LARVAE

RED-SPOTTED
NEWT (ADULTS)

CADDISFLY
LARVAE

* SPOTTED TURTLES LEECHES

* WOOD TURTLES FINGERNAIL (FRESHWATER)
CLAMS

* BLANDINGS TURTLES AMPHIBIOUS AIR-BREATHING
SNAILS



Instructions (continued)

4. Indicate the photographs being

submitted. label, date, and sign all photos.

5. Mark the pool clearly on all maps. The
pool must be clearly distinguished from other
wetlands and be locatable by others. provide
any maps that would help someone unfamiliar

with the area locate the vernal pool in the

FIELD.

6. The form must be signed. Unsigned
submissions will be returned without further
ACTION.

Optional information:

Property owner. Provide information about
PROPERTY OWNER(S), IF KNOWN. It IS RECOMMENDED
THAT YOU SEEK PROPERTY OWNER PERMISSION PRIOR

TO CERTIFICATION ACTIVITIES.

Rare species. A photograph is necessary
for documentation of rare species habitat.

Description. Provide any information that

will distinguish the pool from other wetlands
(boulders, debris, tree species, etc.).

MUST BE LABELED,

DATED, AND SIGNED.Photographs
POOL HOLDING WATER

OBLIGATE +/OR FACULTATIVE SPECIES

DRY POOL (REQUIRED FOR EVIDENCE 3C)

5. Maps submitted

USGS TOPOGRAPHIC MAP (REQUIRED)

AND ONE OR MORE OF THE FOLLOWING:

AERIAL PHOTOGRAPH

SKETCH MAP WITH COMPASS DIRECTIONS AND

DISTANCES FROM LAND MARKS

PROFESSIONAL SURVEY

LARGE SCALE TOPO

OPTIONAL EXTRA INFORMATION

SKETCH MAP OF AREA

assessor's MAP

GPS longitude/latitude coordinates

/"\ -^i.:^ ^ ^ I : ^f~ _.~. .»*:_ —. Although the following information is not required for

Opt Ona ntOrmat On certification, it is useful to NHESP to possibly better
r protect the vernal oool. its habitat and soecies.

Property owner

Name

It is strongly recommended that landowner permission
be obtained prior to collecting certification
documentation.

Address

Town State ZIP_

Rgf0 Wetland 00 Were ANY RARE state-listed species OBSERVED USING

THIS POOL?

species
[yI rfJl IS A PHOTOGRAPH OF THE RARE SPECIES INCLUDED WITH THIS
L-

'

L-
' FILING?

Description of pool and surroundings

Dimensions: approximate length

APPROXIMATE DEPTH

APPROXIMATE WIDTH

Describe distinctive features (roads, structures, boulders, etc) which are visible

from or near the pool.

Are THERE OTHER distinctive FEATURES about this pool (vegetation TYPES, ABANDONED VEHICLES, FOOT

TRAILS, ETC.) THAT WOULD HELP SOMEONE RECOGNIZE IT?

6. Observer information & signature

Name

Address

Town State ZIP

Telephone

e-mail

I hereby certify under the pains and penalties of perjury that the information

contained in this report is true and complete to the best of my knowledge.

Signature Date

Send completed form and
supporting documentation to!

I 1

|

NH&ESP
|

Vernal Pool Certification

MA Division of Fisheries & Wildlife

Route 135

I
Westborough, MA01581 I

l I

All submissions and

supporting documents will be

retained by the Natural Heritage

& Endangered Species Program.

Information submitted on this

form and other documents is

part of the public record and is

available to interested parties

under the State Documents

Request Law.



j^J Natural Heritage &
Endangered Species

Program

Route 135

Westborough, MA 01581

Phone: 508/792-7270 ext. 200

Fax: 508/792-7821

http://www.state.ma.us/dfwele/dfw/nhesp/heritage.htm

PVP Rare Animal Observation Form

* Species name (scientific or common):

* Date and time of observation:

Amount of time spent surveying area:

In order for this form to be processed, the sections preceded by an asterisk (*) must be completed.

* Town: County: Waterbody:

* Please attach a photocopy of the appropriate section of a USGS topo map (or similar map if a topo map is

unavailable) with the site of the observation marked. Please indicate available or occupied habitat and extent of

population, ifknown. Indicate area searched including negative results (i.e. apparently suitable habitat was or was not

surveyed). USGS ( 7.5 or 15 ) Topographic Map Name:

* Describe how to get to the site using obvious permanent landmarks such as a road intersection (measuring to at

least the nearest 1/10 mile).

Number, age, and sex of individuals:

Please describe how age and sex were determined:

Evidence of reproduction (e.g., eggs, nests, carrying food to young, copulation):

Behavioral notes (e.g., crossing the road, basking):

* Photographs taken? ( Y / N ) If Y, please submit one clear photograph.

* Specimen taken? ( Y / N ) If Y, where will the specimen be deposited:

* ID is based on what (e.g., sculpted shell, flight pattern):

Have you observed this species at this site in previous years? ( Y / N ) If Y, please give details:

Commonwealth of Massachusetts

Division ofFisheries & Wildlife, Route 135, Westborough, MA 01581 (508)792-7270 ext. 200

http://www.state.ma.us/dfwele
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Describe the habitat where the species is located. List dominant vegetation, size of the habitat, and information on the

physical environment such as substrate type, hydrology, moisture regime, slope, aspect. Also, if possible provide

information on the surrounding land use.

Associated species:

Alteration of ecological processes (e.g., damming, logging, rip-rapping of stream)? ( Y / N ) If Y, describe:

Observed or potential threats to the species or its habitat at this site:

Landowner's name and address, if known:

Additional comments:

* Observer Information: Name: Phone Number

Address:

Affiliation/Qualifications:

* Form Filled Out By: Name: Phone Number:

(if different from above) Address:

Affiliation/Qualifications:

I hereby certify under pains and penalties of perjury that the information contained in this report is true and complete

to the best of my knowledge.

Signature: Date:

Please submit this form and all supporting documentation (USGS map, photo, etc.) to:

Natural Heritage and Endangered Species Program

MA Division of Fisheries and Wildlife

Route 135

Westborough, MA 01581

(508) 792-7270 ext. 200 Revised 5/98

Commonwealth of Massachusetts

Division of Fisheries & Wildlife, Route 135, Westborough, MA 01581 (508)792-7270 ext. 200

http://www.state.ma.us/dfwele



Suggested Reading

'Vernal 'Tool Identification ant Certification

Colburn, E.A., ed. 1993. Certified: A Citizen s Step-by-Step Guide to Protecting Vernal Pools.

5
th
Edition. Massachusetts Audubon Society, Lincoln, MA.

Kenney, L.P. 1995. Wicked Big Puddles: A Guide to the Study and Certification of Vernal

Pools. Vernal Pool Association, Reading, MA.

Kenney, L.P. and M.R. Bume. 2000. A Field Guide to the Animals of Vernal Pools. MA
Division ofFisheries& Wildlife, Westborough, MA.

^\niphibians/'IZ,eptiles

Behler, J.L. and F.W. King. 1979. The Audubon Society Field Guide to North American

Reptiles andAmphibians. Alfred A. Knopf, New York.

Conant, R. and J.T. Collins. 1998. A Field Guide to Reptiles & Amphibians, Eastern and

CentralNorth America. 3
rd
Edition, Expanded. Houghton Mifflin, Boston, MA.

Hunter, M.L., A.J.K. Calhoun, and M.McCollough, ed. 1999. MaineAmphibians andReptiles.

University ofMaine Press, Orono, ME.

Tyning, T.F. 1990. Stokes Nature Guides: A Guide to Amphibians and Reptiles. Little, Brown
and Company.

Invertebrates

Lehmkuhl, D.M. 1979. How to Know the Aquatic Insects. The Pictured Key Nature Series,

W.C. Brown Company, Iowa.

McCafferty, W.P. 1981. Aquatic Entomology, The Fishermen s and Ecologists ' Illustrated

Guide to Insects and Their Relatives. Jones and Bartlett Publishers, Boston, MA.

Pecharsky, B.L., P.R. Fraissinet, M.A. Penton, and D.J. Conklin, Jr. 1990. Freshwater

Macroinvertebrates ofNortheastern North America. Cornell University Press, Ithaca, NY.

Plants

Redington, C.B. 1994. Plants in Wetlands. Kendall/Hunt Publishing Co., Dubuque Iowa.

Newcomb, L. 1977. Newcomb s Wildflower Guide. Little, Brown and Co., Boston, MA.

Magee, D.W. 1981. Freshwater Wetlands: A Guide to Common Indicator Plants of the

Northeast. University ofMassachusetts Press, Amherst, MA.
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^Kppevibices

Model letter for landowner permission

Vernal Pool Protection - the Local Bylaw





Appendix A

tAAohei Letter for LaribovJner "Termission

Following is a model letter for landowner permission. While the

information presented in the Massachusetts Aerial Photo Survey ofPotential

Vernal Pools should be used to increase vernal pool awareness and protection

through local efforts or through the official Vernal Pool Certification Program,

landowner permission should be obtained, in writing, prior to any field

investigation.

The Massachusetts Natural Heritage & Endangered Species Program

is required to release all information contained in our files when an information

request is made under the state's public documents request law. The official

field form becomes part of the public record and must be released when

requested. The name and address of the observer must be included in the

documents that are released under this law, so it is strongly recommended that

you obtain permission prior to collecting information for certification.

61 Massachusetts 'Vernal 'Fool 5ur\,'eif





Name
Address

Phone number

Date

Landowner name

Street address

Town, State, ZIP

I am writing to ask for your permission to study a potential vernal pool. The local

assessor's records indicate that you own the parcel containing the potential vernal pool I am
interested in. I am (a student / conservation commission member / other). I would like to

visit the potential vernal pool on your property to (explain your interest in the pool).

(If certifying)

Vernal pools are important nurseries for a wide variety ofamphibians (frogs,

toads and salamanders), and are also important to birds, mammals, reptiles, and a host

ofinvertebrates. I will search for evidence ofamphibians or invertebrates that may be

breeding in the vernal pool. Ifthe eggs or young ofvernal pool species are found, I will

take photographs and make notes ofthe animals that are found. This information, along

with maps ofthe vernal pool, will be submitted to the state's Division ofFisheries and

Wildlife for official certification.

The official certification ofa vernal pool on your property could result in protec-

tion under the Massachusetts Wetlands Protection Act, as well as three other state

wetland protection regulations. Although this might result in restriction on certain

activities in or immediately around the pool, such as vegetation cutting or dumping, it

would greatly help the protection ofthe wildlife that depends on these important nurser-

ies.

(Ifnot certifying)

(Explain specifically what you intend to do and how the information

would be used)

I would greatly appreciate your permission to visit the potential vernal pool that is on

your property. I would be happy to talk with you about these important wildlife habitats, and

even bring you out to the pool to show you what I find. I also would like to share the informa-

tion that I collect with you when I am done.

Thank you very much,

Sincerely,

(Sign)

G9 Massachusetts 'Vernal 'Fool 6>ur\'c\f





Appendix B

^Vernal ^PooL ^Protection - the Local 'bi/LaW

The Massachusetts Wetlands Protection Act does not protect vernal

pools that are outside ofjurisdictional resource areas and does not address

the upland habitat needs of terrestrial vernal pool dependent species like the

spotted salamander. The exception to these shortfalls is for vernal pools found

within the 200 foot "Riverfront Area" associated with perennial (permanent)

streams. Vernal pools and their associated uplands, to the extent that they fall

within the Riverfront Area are much more effectively protected. To address

the shortcomings ofthe Wetlands Protection Act, many towns throughout the

Commonwealth have implemented local bylaws, administered by the

conservation commission, that protect any vernal pool (officially certified or

not), and upland habitat surrounding them. Some even refine their definition

to include extremely small vernal pools. When properly constructed and

adequately justified, bylaws are powerful tools for protecting a town's vernal

pool resources along with critical upland non-breeding habitat.

Following are excerpts from the Sudbury bylaw and regulations

pertaining specifically to the definition and protection ofvernal pools. This

bylaw is one ofthe most progressive and comprehensive in the state because

it broadens the definition ofprotectable vernal pools far beyond simply those

that are certified by the NHESP, and establishes the upland area surrounding

vernal pools (as well as all other wetland resource areas) as a resource area

protected under the bylaw. While the specific language is not necessarily

applicable for all towns across the Commonwealth, the Sudbury bylaw provides

useful hints and ideas for crafting a bylaw that will more effectively protect

vernal pools. The complete text can be found at http://home.att.net/

-sudbury.concom/bylaw.htm.

Contact the Massachusetts Association of Conservation

Commissioners (www.maccweb.org) for additional information and assistance

in developing and passing a bylaw for the protection ofyour town's vernal

pools and other critical wetland resources.
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Town of Sudbury Wetlands Administration Bylaw
(Revised June 1998)

Bylaw Section 1. Purpose

The purpose of this bylaw is to maintain the quality of surface water, the quality and level of

the ground water table and water recharge areas for existing, or potential water supplies; to

protect the public health and safety; to protect persons and property against the hazards of

flood water inundation; to protect the community against the costs which may be incurred

when unsuitable development occurs in wetland resource areas; and to provide for the

reasonable protection and conservation of certain irreplaceable natural features, resources

and amenities for the benefit and welfare ofthe present and future inhabitants ofthe Town of

Sudbury.

Accordingly, this bylaw protects the wetlands, related water resources, and certain adjoining

land areas in the Town by providing for prior review and control of activities deemed to have

a significant or cumulative adverse effect upon wetland values, including but not limited to the

following: protection ofpublic and private water supply, protection ofground water, flood

control, erosion and sedimentation control, storm damage prevention, avoidance ofwater

and soil pollution, protection of fisheries, wildlife habitat, rare species habitat including rare

plant species, agriculture, aquaculture, and recreation values, deemed important to the

community (collectively, the "wetlands values protected by this bylaw"). This bylaw is intended

to utilize the Home Rule authority ofthis municipality to protect additional resource areas, for

additional values, with additional standards and procedures to augment those ofthe Wetlands

Protection Act, G.L. Ch 1 3 1 , §40 and Regulations thereunder, 3 1 CMR 10.00.

Bylaw Section 9. Definitions

The following definitions shall apply in the interpretation and implementation ofthis bylaw.

The term "adjacent upland resource area" shall include all lands within 100 feet ofwetland

resource areas as enumerated in section 2, except for perennial streams and rivers for which

the adjacent upland resource area extends for 200 feet from the top ofbank, and except for

vernal pools, ponds under 10,000 square feet in area, and isolated land subject to flooding

for which special adjacent upland resource area definitions are described below.

The term "vernal pool" shall include, in addition to that already defined under the Wetlands

Protection Act, G.L. Ch. 1 3 1 , §40 and Regulations thereunder, 3 1 CMR 1 0.00, any confined
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basin or depression not occurring in existing lawns, gardens, landscaped areas,

or driveways which, at least in most years, holds water for a minimum oftwo

continuous months during the spring and/or summer, contains at least 200

cubic feet ofwater at some time during most years, is free of adult predatory

fish populations, and provides essential breeding and rearing habitat functions

for amphibian, reptile or other vernal pool community species, regardless of

whether the site has been certified by the Massachusetts Division ofWildlife

and Fisheries. The presumption of essential habitat value may be overcome

by the presentation of credible evidence which in the judgment of the

Commission demonstrates that the basin or depression does not provide the

habitat functions as specified in the Bylaw regulations. The adjacent upland

resource area for vernal pools shall extend 100 feet from the mean annual

high-water line defining the depression, or one-halfofthe distance between

the vernal pool and any existing house foundation, which ever is smaller. In

either case the adjacent upland resource area for vernal pools shall not extend

over existing lawns, gardens, landscaped or developed areas.

Sudbury Wetlands Administration Bylaw Regulations

Revised November 2000

Regulations Section 2. Jurisdiction

2.1 Presumption of Vernal Pool Habitat

The Bylaw presumes vernal pool habitat exists if a wetland's physical

characteristics conform with those defined for vernal pools in Section 9

(Definitions) ofthe bylaw: [see above]

This presumptive definition for vernal pools is based on systematic field

observation in the Town ofSudbury by the Sudbury Conservation Commission

showing that virtually all basins that possess the above characteristics actually

host breeding vernal pool species. Undoubtedly this is a particular consequence

ofSudbury's semi-rural character and enduring woodlands and wetlands.

The presumption ofvernal pool habitat may be overcome, however, with the

presentation of credible evidence which in thejudgment ofthe Conservation

Commission demonstrates that the wetland does not provide, or cannot provide,

vernal pool habitat functions.
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2.1.1 Demonstrating that a Ponding Area is not a Vernal Pool

For the purposes ofovercoming the presumption of vernal pool habitat the

Commission will consider:

2.1.1.1 Evidence that the ponding area does not hold water for at

least two continuous months in most years. As a rule ofthumb the

term "most years" shall mean three out of five consecutive years.

2.1.1.2 Evidence that vernal pool species do not breed or have not

bred in the ponding area. The Conservation Commission shall provide

explicit guidelines for this evidence.

2.1.1.3 Evidence that the ponding area could not be a viable breeding

site for vernal pool species due to incompatible physical, chemical,

biological, or other persistent conditions at the site in most years. Such

evidence could include, without limitation, several months ofpH and

dissolved oxygen measurements yielding values incompatible with

amphibian or reptile breeding.

2.1.2 Timing of Evidence Collection

Many of the indicators of vernal pool habitat are seasonal. For example,

certain salamander egg clusters are only found between late March and late

May. Wood frog chorusing only occurs between late March and May, and

then only at night. Consequently, failure to find evidence ofbreeding must be

tied explicitly to those periods during which the evidence is most likely to be

available.

Accordingly, in the case ofchallenges to the presumption ofvernal pool habitat

the Conservation Commission may require that the determination be postponed

until the appropriate time period consistent with the evidence being presented.

The Commission may also require its own site visits as necessary to confirm

the evidence.
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Regulations Section 7. Permits and Conditions

7.1 Performance Standards & Design Criteria for Adjacent Upland

Resources

As stated in the Bylaw, Section 7 Permits and Conditions lands within 100

feet ofwetlands resource areas (25 feet in the case of isolated land subject to

flooding):

"...are presumed important to the protection of these resources because

activities undertaken in close proximity to wetlands and other resources have

a high likelihood ofadverse impact upon the wetland or other resource, either

immediately, as a consequence ofconstruction, or over time, as a consequence

of daily operation or existence ofthe activities. These adverse impacts from

construction and use can include, without limitation, erosion, siltation, loss of

groundwater recharge, poor water quality, and harm to wildlife habitat.

The Commission may therefore require that the applicant maintain a strip of

continuous, undisturbed vegetative cover in part or all of the 100-foot area

and set other conditions on this area, unless the applicant provides evidence

deemed sufficient by the Commission that the area or part of it may be disturbed

without harm to the values protected by the law."

7.2 Considerations in Setting Disturbance Restrictions.

A growing body of research evidence suggests that even "no disturbance"

areas reaching 1 00 feet from wetlands may be insufficient to protect many

important wetland resource characteristics and values. Problems ofnutrient

runoff, water pollution, siltation, erosion, vegetation change, and habitat

destruction are greatly exacerbated by activities within 100 feet ofwetlands.

Thus, in general work and activity within 1 00 feet ofwetlands should be avoided

and discouraged and reasonable alternatives pursued.

Accordingly, the Conservation Commission shall begin with the presumption

that lands within the adjacent upland resource ofa resource are best left in an

undisturbed and natural state. [Note: the Bylaw contains a number of

exemptions for single family residences existing prior to July 27, 1 994]
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However the Commission shall designate areas ofthe adjacent upland resource

to be suitable for temporary, limited, or permanent disturbance as appropriate

when the applicant can demonstrate to the Commission's satisfaction that the

proposed work or activity will not affect wetland values singularly or

cumulatively and that reasonable alternatives to the proposed work or activity

do not exist.

In considering designation of adjacent upland resource disturbance areas, the

types ofwork and activities allowable, and conditions to apply, the Conservation

Commission shall consider:

7.2.1 Values and Functions of the Resource Area

The quantity and quality ofresource values and functions should be considered

explicitly in placing conditions on adjacent upland resource work. Some

isolated land subject to flooding, for example, may serve for temporary flood

storage only. Minimal adjacent upland resource restrictions within several

feet ofthe resource might be necessary only to prevent erosion.

Other isolated land subject to flooding might provide vernal pool habitat. It

might also provide important flood storage capacity and intersect ground water.

In this instance far stronger adjacent upland resource restrictions would be

appropriate because a larger number of functions are involved and some

functions, such as habitat, are more sensitive to adjacent upland resource activity

and require greater protection. If rare or endangered species, such as blue

spotted salamanders, were found at the site then still greater levels ofrestrictions

would be appropriate.

7.2.3 Wildlife Habitat and Rare Species

The near-upland areas around wetland resources often play important roles in

determining and maintaining the wildlife habitat values ofassociated wetlands.

While it is common to think ofthe protective or "buffering" value of adjacent

upland resources in terms of area undisturbed, habitat values may be equally

affected by the configuration ofthe adjacent upland resource perimeter, the

inclusion or exclusion of specific topographical and ecological features (such

as an abutting sandy knoll or tree canopy), etc.
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Therefore where significant wildlife habitat values and functions are present

delineation ofnon-disturbance areas within the adjacent upland resource shall,

as is reasonable, minimize the length ofperimeter to area left undisturbed,

exclude fingers, islands, or other projections or indentations of the non-

disturbance zone, and in general avoid delineating oddly shaped non-disturbed

areas. The Commission shall give special attention to inclusion inside the no

disturbance area ofthose topographical and ecological features that it deems

important for maintaining the wildlife habitat value ofthe resource.

The potential presence of rare or endangered species and their specific

sensitivity to adjacent upland resource activity shall be considered in determining

adjacent upland resource restrictions. Evidence ofthe presence ofsuch species

or evidence of likely habitat shall be considered by the Conservation

Commission. Prior designation or rare or endangered species habitat by the

Division ofFisheries and Wildlife Natural Heritage Program is not necessary.

The Commissionmay consult with the Division ofFisheries and Wildlife Natural

Heritage Program or other authorities as it deems necessary for guidance and

recommendations

.

7.2.4 No Significant Adverse Impact on Wildlife Habitat

Wildlife habitat serves a variety of functions in support of wildlife. Food,

water, breeding space, shelter, security, movement and migration space, and

connections to other habitat areas are all equally important. All ofthese wildlife

habitat functions are presumed to exist in all resource areas.

Therefore in accordance with the Bylaw's fundamental purposes (see Bylaw,

Section 1 above) no project may have a significant adverse impact - either

project-specific or cumulative - on wildlife habitat for more than two growing

seasons.

For wildlife habitat purposes, a significant adverse project-specific impact is

defined as an impact caused by work in a resource area that would under

reasonable assumptions (a) result in a measurable decrease in the extant wildlife

populations or biological composition, structure, or richness on the site or in

the vicinity exclusive of the present or future state of adjacent and nearby
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properties, or (b) impair, damage, destroy, or reduce in value for wildlife

purposes certain specific habitat features.

Wildlife studies have shown that direct impacts from work - filling, grading,

vegetation removal, construction of barriers to movement, etc. - in resource

areas can severely harm wildlife populations. For example, low stone walls

bisecting a resource area can prevent amphibians that live in upland areas

from reaching breeding pools, marshes, and streams. Or, removal of large

snags (dead trees) can virtually eliminate nesting by barred owls, pileated

woodpeckers, mink, etc. Accordingly, the Commission shall prohibit the

placement offences or other barriers to wildlife movement within and between

resource areas and the destruction of specific habitat features.

Examples ofprotected habitat features include (but are not limited to):

Large cavity trees

Turtle nesting areas

Existing nest trees for birds that reuse nests

Beaver dams, dens, and lodges

Mink or otter dens

Vernal pools

Vertical sandy banks

Migration corridors that provide connectivity between wildlife habitats

Sphagnum hummocks and pools suitable to serve as nesting habitat for

four-toed salamanders

But indirect impacts - the effects ofhuman activities near wildlife habitat - can

have equally harmful effects. Therefore the Commission shall take into account

indirect effects on a project by project basis. So, for example, no work

within resource areas shall be permitted within 100 feet of existing beaver,

mink or otter dens, or within 200 feet of existing osprey or great blue heron

nests.

As clearly stated in Section 1 ofthe Sudbury Wetlands Administration Bylaw

the purpose ofthe Bylaw is to preserve for future generations ofresidents the

natural resources and amenities - including wildlife - we presently enjoy in

Sudbury. The Bylaw protects future values as well as current ones. Therefore,

the Commission must be especially cognizant ofthe likely cumulative impact

ofwork within resource areas.
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For wildlife habitat purposes a significant cumulative adverse impact is defined

as an impact that would under reasonable assumptions result in a measurable

decrease in the extant wildlife populations or biological structure, composition,

or richness on the site or in the vicinity taking into account the projected impacts

offuture projects that could be proposed in the vicinity with similar, comparable,

or other significant impacts and disturbance.

This method for assessing cumulative impacts avoids the pitfall ofplacing an

unreasonable burden ofresource protection on subsequent applicants/projects

in the vicinity while subsidizing those who are first to develop land. It allows

the Commission to level the marginal impact of all proposed projects in the

vicinity while ensuring appropriate protection - present and future - of the

values and interests protected by the Bylaw.

Regulations Section 9 DEFINITIONS

9.10 Vernal Pool Species

Any species ofreptile, amphibian, or invertebrate that breeds in a vernal pool.

These species may be obligate or facultative.
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The Natural Heritage & Endangered Species Program is very proud to

present the Massachusetts Aerial Survey of Potential Vernal Pools. This

Compact Disc contains the program and data files that will allow users to

view and print USGS topographic maps with the Potential Vernal Pools

identified in this survey. Detailed installation instructions and system
requirements are found on pages 22 through 25. Please make note of

the instructions on page 24, these are very important to the proper
functioning of the program.




